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Chapter 1. Migrating to WebSphere MQ for Windows Version
7.0

Follow this information to migrate from previous versions of WebSphere® MQ for
Windows® to WebSphere MQ for Windows Version 7.0.

Before you upgrade to WebSphere MQ Version 7.0, you must consider this
information.

If you migrate from a previous level of this product without first backing up your
system, you cannot revert to your previous level, so back up your system before
you install WebSphere MQ Version 7.0. This enables you to back out the upgrade if
necessary. If you back out the upgrade, however, you cannot recover any work,
such as changes to messages and objects, for example, performed by WebSphere
MQ Version 7.0. For distributed platforms, information about how to back up your
system begins with Backing up and restoring WebSphere MQ in the WebSphere
MQ System Administration Guide.

The installation process for WebSphere MQ for Windows detects whether this is a
new installation or an update from a previous level of this product. If you migrate
from a previous level, all the objects that you previously created (for example, your
queue managers) can be maintained. The components that were previously
installed are preselected in the feature options when you install the new level. If
you leave these components selected, you can keep them or reinstall them.
However, if you deselect any of these components, the installation process
uninstalls them.

You can also migrate to WebSphere MQ V7.0 on a system where a previous version
has been uninstalled but where the queue manager data has been retained.

If an earlier version of WebSphere MQ is installed on the computer:
v Ensure that no queue managers, listeners, MQ applications or remote

applications that use queue managers are running and that the WebSphere MQ
Service is stopped. To stop the WebSphere MQ Service, right-click on the
WebSphere MQ icon in the system tray, then click Stop WebSphere MQ.

v When the installation of WebSphere MQ Version 7.0 completes, the Prepare
Websphere MQ Wizard launches automatically. Use this wizard to reenter
domain, user ID and password information.
You can subsequently use the DCOMCNFG.EXE tool, shipped with Windows
systems, to change the domain, user ID, and password information.This tool is
described in WebSphere MQ System Administration Guide

For Windows Vista and Windows Server 2008 users with UAC enabled only: if
you do not complete the Prepare WebSphere MQ Wizard directly after
WebSphere MQ installs or if for any reason your machine is rebooted between
completing WebSphere MQ installation and completing the Prepare WebSphere
MQ Wizard, ensure the wizard is run with Administrator privilege, otherwise
the wizard might fail.

v WebSphere MQ Version 7.0 supports migration from WebSphere MQ Version 5.3
and WebSphere MQ Version 6.0 only.

© Copyright IBM Corp. 1996, 2009 1
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v WebSphere MQ Version 7.0 does not coexist with previous versions of
WebSphere MQ. You must migrate from either WebSphere MQ Version 5.3 or
WebSphere MQ Version 6.0 to WebSphere MQ Version 7.0.

v By default, a typical WebSphere MQ Version 6.0 to Version 7.0 migration installs
only the same features that were installed in the previous version installation.
For example, if WebSphere MQ Explorer was not installed in the Version 6.0
installation, it is not installed in a Version 7.0 installation. If you want
WebSphere MQ Explorer, select a custom installation of WebSphere MQ Version
7.0 and select the MQ Explorer feature on the Features panel. If you are
migrating from WebSphere Version 5.3 to Version 7.0, WebSphere MQ Explorer is
installed by default. If you do not want WebSphere MQ Explorer, uninstall the
WebSphere MQ Explorer feature by selecting a custom installation of WebSphere
MQ Version 7.0. Then deselect the MQ Explorer feature on the Features panel.
For more information on how to deselect features, see Launchpad instructions in
Quick Beginnings for Windows.

Choosing not to install WebSphere MQ Explorer and WebSphere
Eclipse Platform

You can choose not to install the WebSphere MQ Explorer feature, during a custom
installation.

By default, a typical migration installation enables the WebSphere MQ Explorer
feature. WebSphere MQ Explorer has a prerequisite of WebSphere Eclipse Platform
V3.3.

If you do not want to install WebSphere Eclipse Platform V3.3, select a custom
installation then deselect the WebSphere MQ Explorer feature from the Features
panel.

If you installed WebSphere MQ Explorer on WebSphere MQ Version 6.0 but do not
want to install it on WebSphere MQ Version 7.0, select a custom installation and
then deselect the WebSphere MQ Explorer feature. The migration process removes
the Version 6.0 WebSphere MQ Explorer feature.

For more information on how to deselect features, see Launchpad instructions in
Quick Beginnings for Windows.

Migrating to WebSphere MQ Version 7.0 on Windows Vista or Windows
Server 2008

You can migrate to WebSphere MQ Version 7.0 on Windows Vista or Windows
Server 2008 using either of the following supported migration paths:

Table 1. WebSphere MQ Version 7.0 on Windows Vista or Windows Server 2008: supported
migration paths

From: To:

WebSphere MQ Version 6.0 Client plus
FixPack 6.0.2.1 on Windows Vista or
Windows Server 2008

WebSphere MQ Version 7.0 Client on
Windows Vista or Windows Server 2008

WebSphere MQ Version 7.0 on Windows XP
SP2

WebSphere MQ Version 7.0 on Windows
Vista or Windows Server 2008
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User Account Control (UAC) on Windows Vista and Windows Server
2008

Windows Vista and Windows Server 2008 introduce a User Account Control (UAC)
feature, which restricts the actions users can perform on certain operating system
facilities, even if they are members of the Administrators group.

UAC is enabled by default on Windows Vista and Windows Server 2008. This
means installing WebSphere MQ on Windows Vista or Windows Server 2008
differs from installing WebSphere MQ on previous versions of Windows. At certain
points during installation, migration, and uninstallation, you must manually accept
the Windows UAC prompt to allow processes to run with elevated authority.
During silent installation and uninstallation, you must invoke the process from an
elevated command prompt. The points when you have to accept the Windows
prompt for UAC or invoke processes from an elevated command prompt have
been flagged in the specific topics affected.

Chapter 1. Migrating to WebSphere MQ for Windows Version 7.0 3
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Chapter 2. Migrating from WebSphere MQ Version 5.3 and 6.0

If you are migrating from a previous version of WebSphere MQ, you should
consider the information given in the following section:
v “Launchpad migration instructions”

Launchpad migration instructions
About this task

These instructions cover migrating WebSphere MQ to Version 7.0 using the
launchpad.
1. Stop all existing WebSphere MQ processes.

a. Stop execution of all WebSphere MQ applications on the local machine, and
on any connected remote machines.

b. Stop execution of all queue managers
c. Stop execution of all channels
d. Stop execution of all listeners
e. Right click WebSphere MQ on the system tray and select Stop WebSphere

MQ. Wait for all services to stop.
f. Right click WebSphere MQ on the system tray and select Exit. Some

previous versions of WebSphere MQ might not have an Exit option. If there
is not, use the task manager to end process amqmsrvn.exe.

2. Insert the WebSphere MQ Version 7.0 Server CD into the CD-ROM drive.
3. If autorun is enabled, the launchpad starts automatically. If not, run setup.exe

from the CD-ROM.
If you are migrating on Windows Vista or Windows Server 2008 and UAC is
enabled, accept the Windows prompt to allow the launchpad to run as
elevated. During migration you might also see Open File - Security Warning
dialog boxes that list International Business Machines Limited as the publisher.
Click Run to allow the migration to continue.

4. Click the Software Requirements option to check if prerequisites are met. You
might need to install or upgrade to WebSphere Eclipse Platform Version 3.3 if
you want to use WebSphere MQ Explorer in WebSphere MQ Version 7.0.

5. Click the Network Configuration option and select from the three choices.
Click More Information to launch the relevant WebSphere MQ documentation.

6. Click the Migrating SSL Certificates option and select from the choices. This
option will only appear if you are migrating from WebSphere MQ Version 5.3,
otherwise it will not be shown.

7. Click the WebSphere MQ Installation option, check the pre-installation status,
select language, and click Launch IBM WebSphere MQ Installer.
a. Read and accept the license agreement to proceed.
b. Select update or custom. Update installs WebSphere MQ Version 7.0 with

the same features as the previous version. Custom allows you to add or
remove components for the new version.
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c. If custom was selected, choose components. Unselecting a component will
remove the component from the machine if it is already installed.
WebSphere MQ Explorer requires WebSphere Eclipse Platform 3.3 to have
been installed.

d. Confirm details and install. Follow any on-screen instructions.
e. Restart computer on completion of installation if you are prompted to do

so.
f. WebSphere MQ will launch some final configuration steps, allowing you to

review network configuration options, and select components to start up
when finished.

8. WebSphere MQ Version 7.0 is now installed, and all persistent items have been
migrated from the previous version of WebSphere MQ. You can use the
launchpad to view the Quick Beginnings, Release Notes, or Product Tour before
finishing.
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Chapter 3. Migrating from WebSphere MQ Version 5.3

If you are migrating from WebSphere MQ Version 5.3, you should also consider the
information given in the following sections:
v “Migrating SSL connections”
v “Migrating WebSphere MQ Services”
v “Publish/Subscribe users” on page 8
v “Saved views with WebSphere MQ Explorer” on page 8

Migrating SSL connections

WebSphere MQ for Windows, Version 7.0 provides the Global Security Toolkit
(GSKit) for improved Secure Sockets Layer (SSL) support for queue manager and
WebSphere MQ client channels. If you have WebSphere MQ Version 5.3 queue
managers or clients set up to use SSL connections, or if you are unsure if your
queue managers or clients have been set up in this way, refer to WebSphere MQ
Migration Information.

Follow the guidance in WebSphere MQ Migration Information to determine
whether WebSphere MQ Version 5.3 queue managers or clients have been set up to
use SSL connections, and to ensure these channels continue to work with
WebSphere MQ for Windows, Version 7.0 . The migration process causes a copy of
the certificates stored in the WebSphere MQ Version 5.3 Certificate Stores used by
WebSphere MQ Version 5.3 to be migrated to a GSKit Key database.

Migrating WebSphere MQ Services
WebSphere MQ services define one or more commands to be run when a queue
manager is started or stopped. Examples of a service include:
v Listener
v Channel initiator
v Trigger monitor
v Command server
v Channel
v Queue manager custom service

When migrating from a version of WebSphere MQ earlier than Version 6, the
WebSphere MQ services are automatically migrated into WebSphere MQ Objects.
(For more information about WebSphere MQ Objects see the WebSphere MQ
System Administration Guide.) These objects can then be administered in the
WebSphere MQ Explorer.

Examples of the migration of services to WebSphere MQ Objects are:
v A listener is migrated to a WebSphere MQ listener object, equivalent to one

defined by the DEFINE LISTENER ... MQSC command.
v A trigger monitor is migrated to a WebSphere MQ service object with STARTCMD

set to runmqtrm.
v A channel is migrated to a WebSphere MQ service object with STARTCMD set to

runmqchl.

© Copyright IBM Corp. 1996, 2009 7
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It is important to note that after migration all services will run after the queue
manager with which they are associated starts. This is the case even if the service
previously ran before the associated queue manager started.

Only services that are associated with queue managers will be migrated. ROOT
custom services, which are services that are not associated with a particular queue
manager, are not migrated and they will remain as they were.

Publish/Subscribe users
WebSphere MQ Version 7.0 contains components that provide Publish/Subscribe
support that were previously shipped in SupportPac™ MA0C and included in Fix
Pack 8 for WebSphere MQ Version 5.3. If you install WebSphere MQ Version 7.0,
you no longer need the SupportPac and you should not install it. The files
included with WebSphere MQ Version 7.0 supersede those in the SupportPac.

If you are using SupportPac MA0C with your previous version of WebSphere MQ,
uninstall before you install WebSphere MQ Version 7.0. Uninstall by selecting Start
→ Settings → Control Panel → Add or Remove Programs → IBM MQSeries
Publish/Subscribe, and then selecting Remove.

Saved views with WebSphere MQ Explorer
WebSphere MQ Version 5.3 uses Microsoft® Management Console (MMC) based
snap-ins to provide the WebSphere MQ Explorer. MMC allows you to save the
current configuration or ’view’ as a .msc file.

WebSphere MQ Version 7.0 no longer uses MMC. Therefore, any views that you
have previously saved will not work with the WebSphere MQ Explorer.

8 WebSphere MQ: Quick Beginnings for Windows
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Chapter 4. Installing the WebSphere MQ Server

This topic describes how to install WebSphere MQ Version 7.0 directly from the
WebSphere MQ Server CD.

This information covers topics such as preparing for installation and verifying your
installation, as well as the installation process itself. If you already have an
installation of WebSphere MQ, and are migrating to WebSphere MQ Version 7.0,
see Chapter 1, “Migrating to WebSphere MQ for Windows Version 7.0,” on page 1
or Chapter 2, “Migrating from WebSphere MQ Version 5.3 and 6.0,” on page 5
before carrying out the installation process.

WebSphere MQ can be installed as a server or a client. A WebSphere MQ server is
an installation of a queue manager that provides queueing services to zero or more
clients and to zero or more queue managers. All the WebSphere MQ objects, for
example queues, exist only on the queue manager machine (the WebSphere MQ
server machine), and not the client. A WebSphere MQ server can also support local
WebSphere MQ applications.

A WebSphere MQ client is a component that allows an application running on one
system to communicate with a queue manager running on another system. The
output from the call is sent back to the client, which passes it back to the
application. A WebSphere MQ client can be installed on its own on a separate
machine from the base product and server.

For an introduction to WebSphere MQ concepts and objects, see the WebSphere
MQ System Administration Guide.

For information about client support in general, see WebSphere MQ Clients.

You can use the WebSphere MQ Server CD to install the WebSphere MQ server or
the WebSphere MQ client. If you want to install the WebSphere MQ server and the
WebSphere MQ client on the same machine, you must use the WebSphere MQ
Server CD.

Note:

v You can also install the WebSphere MQ client by using the WebSphere MQ
Client CD. The installation methods you use with this CD differ slightly. See
WebSphere MQ Clients for more information.

This chapter describes how to install the WebSphere MQ Server using the
WebSphere MQ for Windows CD. If you wish to install the WebSphere MQ Client
see Chapter 5, “Installing the WebSphere MQ Client,” on page 75.

This chapter is broken down into the following categories:
v Chapter 6, “Installing WebSphere MQ documentation,” on page 89
v “Preparing for server installation” on page 12
v “WebSphere MQ Server installation methods” on page 22
v “Configuring a WebSphere MQ Server” on page 52

© Copyright IBM Corp. 1996, 2009 9
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General considerations
v Ensure that you set up default logging for the installation process. See “Creating

a log file when you install WebSphere MQ” on page 11.

Naming considerations
v Ensure that the machine name does not contain any spaces. WebSphere MQ does

not support machine names that include spaces. If you install WebSphere MQ on
such a machine, you cannot create any queue managers.

v For WebSphere MQ authorizations, names of user IDs and groups must be no
longer than 20 characters (spaces are not allowed).

v A WebSphere MQ for Windows server does not support the connection of a
Windows client if the client is running under a user ID that contains the @
character, for example, abc@d.

Security considerations
v Are you installing WebSphere MQ on a network where the domain controller is

on a Windows 2000 or Windows 2003 server? If so, you probably need to obtain
a special domain account from your domain administrator. For further
information, and the details that the domain administrator needs to set up this
special account, refer to “Configuring WebSphere MQ accounts” on page 57.

v You must have local administrator authority when you are installing. Define this
authority through the Windows facilities.

v Your user ID must belong to the local mqm or Administrators group in order to
administer any queue manager on that system, or to run any of the WebSphere
MQ control commands. If the local mqm group does not already exist on the local
computer, it is created automatically when WebSphere MQ is installed. The user
ID can either belong to the local mqm group directly, or belong indirectly through
the inclusion of global groups in the local mqm group.

v Windows Vista and Windows Server 2008 introduce a User Account Control
(UAC) feature, which restricts the actions users can perform on certain operating
system facilities, even if they are members of the Administrators group. See User
Account Control (UAC) on Windows Vista and Windows Server 2008 for more
information. If your userid is in the Administrators group but not the mqm
group you must use an elevated command prompt to issue MQ admin
commands such as crtmqm, otherwise the error ″AMQ7077: You are not
authorized to perform the requested operation″ is generated. To open an
elevated command prompt, right-click the start menu item, or icon, for the
command prompt, and select ″Run as administrator″.

v Some commands can be run without being a member of the mqm group (see
Authority to administer WebSphere MQ).

v If you intend to administer queue managers on a remote system, your user ID
must be authorized on the target system. The information on protecting
WebSphere MQ resources in the WebSphere MQ System Administration Guide
includes more information on this topic.

v A user account that is used to run the IBM® WebSphere MQ Services COM
server is set up by default during the installation process, typically with the user
ID MUSR_MQADMIN. This account is reserved for use by WebSphere MQ.
Refer to “Configuring WebSphere MQ accounts” on page 57.

v When an MQ client connects to a queue manager on the server, the username
under which the client runs must not be same as the domain or machine name.

10 WebSphere MQ: Quick Beginnings for Windows
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If the user has the same name as the domain or machine, the connection fails
with return code 2035(MQRC_NOT_AUTHORIZED).

v As with other versions of Windows, the Object Authority Manager (OAM) gives
members of the Administrators group the authority to access all MQ objects
even when UAC is enabled on Windows Vista and Windows Server 2008.

For further information about WebSphere MQ user IDs on Windows systems and
the WebSphere MQ Object Authority Manager (OAM), see the WebSphere MQ
System Administration Guide.

Creating a log file when you install WebSphere MQ
WebSphere MQ for Windows is installed using the Microsoft Installer (MSI). To
generate a log file during installation, you need to set up default logging. This
means that a log file is created each time that you install software that uses MSI. If
you install WebSphere MQ using the Launchpad, a log file will automatically be
generated. For more information see, “Final Installation tasks” on page 56.

Default logging
About this task

To set up logging, use the following steps:
1. Launch the msiconfig snap-in to display the msiconfig window. If this is

already set up on your machine, click Start → Programs → Administrative Tools
→ msiconfig.msc. The Start Menu properties might need to be changed to
display Administrative Tools in it. Otherwise, use the following steps to set it
up:
a. From the Windows taskbar, click Start → Run.
b. Type mmc, then click OK to display the Console window.
c. Click File → Add/Remove Snap-in to display the Add/Remove Snap-in

dialog.
d. Click Add to display the Add Standalone Snap-in dialog.
e. Select Group policy Object Editor from the list, then click Add to display

the Select Group Policy Object dialog.
f. Apply the Group Policy appropriate to your domain configuration. For

example, if you are using a local computer, click Finish.
g. In the Add Standalone Snap-in dialog, click Close.
h. In the Add/Remove Snap-in dialog, click OK.

Note: Step 1.d an 1.g do not apply to Windows Vista.
2. From the tree in the left-hand panel of the window, expand the following:

Local Computer Policy → Computer Configuration → Administrative
Templates → Windows Components

3. Click Windows Installer.
4. In the Policy panel, right click Logging, then click Properties from the resulting

menu. The Logging Properties dialog is displayed.
5. Click the Enabled option.
6. In the Logging field, type:

microwaveup

Click OK.
7. Save the new setting as msiconfig and close the msiconfig window.
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Preparing for server installation
Before you start to install WebSphere MQ review the release notes file, which is on
the product CD in the \Readmes folder for each national language. This file
contains any additional information about the WebSphere MQ for Windows,
Version 7.0 product and might update information in this book.

There is also a READADD.txt file for any changes made between translation and
the manufacturing of the installation CD. The READADD.txt can be found in:
pathname\READADD.txt where pathname is the path of the server installation CD.

During installation, the release notes file is copied to the WebSphere MQ program
files folder (default c:\Program Files\IBM\WebSphere MQ).

For server hardware and software requirements see:
v “Server hardware for WebSphere MQ for Windows”
v “Prerequisite server software”
v “Optional server software” on page 18

Server hardware for WebSphere MQ for Windows
Hardware required to run WebSphere MQ for Windows in the server environment.

This information applies to the server environment only. For details of the
WebSphere MQ for Windows client environment, see “Client hardware” on page
76.

Hardware requirements of WebSphere MQ server
v Any x86 or x86-64 technology-compatible PC hardware, capable of running the

required level of a compatible operating system .
v Any communications hardware supporting SNA LU 6.2, TCP/IP, NetBIOS, or

SPX is required for communication with other machines.
v The following disk space (for a typical installation):

– 570 megabytes (MB) for product code and data (not including the Information
Center)

– 20 MB minimum working space
– 30 MB of temporary space for the installation process

Hardware requirements of WebSphere MQ Explorer

If you want to use the WebSphere MQ Explorer, you will need a minimum of:
v 512 MB RAM
v 1 GHz processor
v 300 MB for Eclipse platform code and data
v A suitable monitor for the operating system with a screen size of at least

1024x768

Prerequisite server software

This information applies to the server environment only. For details of the
WebSphere MQ for Windows client environment, see “Prerequisite client software”
on page 76.
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For details of the prerequisites for individual features of the product, see
“Prerequisites for WebSphere MQ for Windows features” on page 20.

For the most up to date information regarding prerequisite software, refer to the
readme file.

The following are the prerequisites for running WebSphere MQ for Windows;
minimum supported levels are shown. Later compatible levels, if any, are
supported, unless otherwise stated.

Operating systems
Operating systems for WebSphere MQ for Windows in the server environment.

WebSphere MQ requires one of the following operating systems:
v Microsoft Windows Server 2003. This can be one of the following products:

– Microsoft Windows Server 2003 Standard Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Enterprise Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Standard x64 Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Enterprise x64 Edition (Service Pack 1 or

later)
– Microsoft Windows Server 2003 R2 Standard Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 R2 Enterprise Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 R2 Standard x64 Edition (Service Pack 1 or

later)
– Microsoft Windows Server 2003 R2 Enterprise x64 Edition (Service Pack 1 or

later)
v Microsoft Windows XP Professional. This can be either of the following

products:
– Microsoft Windows XP Professional (Service Pack 2 or later)
– Microsoft Windows XP Professional x64 Edition

v Microsoft Windows Vista. This can be one of the following products:
– Microsoft Windows Vista Business Edition
– Microsoft Windows Vista Enterprise Edition
– Microsoft Windows Vista Ultimate Edition
– Microsoft Windows Vista Business x64 Edition
– Microsoft Windows Vista Enterprise x64 Edition
– Microsoft Windows Vista Ultimate x64 Edition

v Microsoft Windows Server 2008. This can be one of the following products:
– Microsoft Windows Server 2008 Standard Edition
– Microsoft Windows Server 2008 Enterprise Edition
– Microsoft Windows Server 2008 Datacenter Edition
– Microsoft Windows Server HPC 2008
– Microsoft Windows Server Web 2008
– Microsoft Windows Server Storage 2008
– Microsoft Windows Server 2008 Standard x64 Edition
– Microsoft Windows Server 2008 Enterprise x64 Edition
– Microsoft Windows Server 2008 Datacenter x64 Edition
– Microsoft Windows Server Web 2008 x64
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– Microsoft Windows Server Storage 2008 x64
– Microsoft Windows Small Business Server 2008 x64 for small businesses
– Microsoft Windows Essential Business Server 2008 x64 for medium-sized

businesses
– Microsoft Windows Server 2008 for Itanium-based Systems

Installing on 64-bit Windows operating systems

There are no 64-bit specific actions that need to be performed to install and use
WebSphere MQ on a 64-bit Windows system.

Install directory used for 64-bit Windows operating systems

On 64-bit Windows, the default installation location is C:\Program Files
(x86)\IBM\WebSphere MQ as opposed to C:\Program Files\IBM\WebSphere MQ.
If you explicitly set the installation program to install WebSphere MQ in
C:\Program Files\IBM\WebSphere MQ, an error dialog will appear with the text:
This is a 32 bit program and cannot be installed to the 64 bit program files
directory. Please either use 'C:\Program Files (x86)' or choose an
alternative location. (AMQ4765)

and you must select an alternative installation directory. In a silent install the error
message will be written to the install log.

Wherever the default installation location occurs in the documentation or
C:\Program Files\IBM\WebSphere MQ is specifically documented, for 64-bit
operating systems the file path should be read C:\Program Files
(x86)\IBM\WebSphere MQ.

Connectivity
Supported software products to enable connectivity for Websphere MQ for
Windows

You require one of the following products:
v for SNA connectivity:

– IBM Communications Server for Windows, Version 6.1.2
– IBM Personal Communications for Windows Version 5.9, part of IBM Host

Access Client Package (HACP) V4.0
– Attachmate myEXTRA! Presentation Services, Version 7.11
– Attachmate EXTRA! X-treme V9
– Microsoft Host Integration Server 2006

v TCP/IP, NetBIOS, and SPX. These are part of the base operating system (SPX is
part of Windows XP and Windows 2003 only).

v WebSphere MQ client applications are supported on the Citrix Presentation
Server V4.5

Prerequisites for Windows XP and Windows Server 2003
Additional software required to run WebSphere MQ for Windows in the server
environment on Windows XP or Windows Server 2003 .

Additional prerequisites for Windows XP and Windows Server 2003 are:
v For running .NET services, Microsoft Internet Information Services
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Installing prerequisite software

This describes the two alternative methods for installing prerequisite software.

To install the prerequisite software provided on the WebSphere MQ Server CD
(which does not include service packs or Web browsers), do one of the following:
v Use the WebSphere MQ installation procedure.

When you install using the WebSphere MQ Server CD, there is a Software
Prerequisites option in the WebSphere MQ Installation Launchpad window. You
can use this option to check which prerequisite software is already installed and
which is missing, and to install any missing software. See “Launchpad
instructions” on page 23.

v Use the Windows Explorer:
1. Use the Windows Explorer to select the Prereqs folder on the WebSphere MQ

Server CD.
2. Select the folder for the software item to be installed.
3. Start the installation program.

Installing and uninstalling IBM WebSphere Eclipse Platform
About this task

The WebSphere Eclipse Platform can be installed either from the WebSphere MQ
installation launchpad or unattended (silently). To process an unattended
installation, see: “Unattended (silent) install and uninstall of IBM WebSphere
Eclipse Platform” on page 16. To install from the WebSphere MQ installation
launchpad you must:
1. Insert the WebSphere MQ for Windows Server CD into the CD-ROM drive.
2. If autorun is enabled, the installation process starts.

Otherwise, double-click the Setup icon in the root folder of the CD to start the
installation process.
If you are installing on Windows Vista or Windows Server 2008 and UAC is
enabled, accept the Windows prompt to allow the launchpad to run as
elevated. During installation you might also see Open File - Security Warning
dialog boxes that list International Business Machines Limited as the publisher.
Click Run to allow the installation to continue.
The WebSphere MQ Installation Launchpad window is displayed.

3. Click the Software Prerequisites option.
The window lists the prerequisite software for a typical installation. To the right
of each installation item there is a green circle and the word “OK” if the
software is installed, or a red circle with the words “Not Installed” if the
software is not installed.
If there is a red circle with the words “Not Installed” next to WebSphere
Eclipse Platform:
a. Click the + symbol to the left of WebSphere Eclipse Platform to display

installation links.
b. Select the option for the installation source you want to use. Select from:
v CD-ROM
v Network

4. The language selection panel is displayed. Select the language you want and
click OK. The WebSphere Eclipse Platform setup wizard is displayed. Follow
the instructions given in the wizard to install WebSphere Eclipse Platform.
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If you are installing on Windows Vista or Windows Server 2008 and UAC is
enabled, accept the Windows prompt to allow the wizard to run as elevated.
During installation you might also see Open File - Security Warning dialog
boxes that list International Business Machines Limited as the publisher. Click
Run to allow the installation to continue.

What to do next

If you no longer need your previous version of WebSphere Eclipse Platform (for
example Version 3.01), you can remove it after you have installed this newer
version of WebSphere Eclipse Platform, Version 3.3.

WebSphere Eclipse Platform can be uninstalled using Add/Remove Programs or
Programs and Features.

For Windows XP or Windows 2003, follow these steps:
1. From the Windows taskbar, click Start → Settings → Control Panel.
2. Double-click Add/Remove Programs.
3. Click IBM WebSphere Eclipse Platform V3.01 (or whatever your old version

is).
4. Click Remove. When a confirmation prompt is displayed, click Yes. The

uninstall program begins. All the IBM WebSphere Eclipse Platform files are
removed.

For Windows Vista or Windows Server 2008, follow these steps:
1. From the Windows taskbar, click Start >Control Panel . The Programs window

opens.
2. Double-click Programs and Features. The Programs and Features window

opens.
3. Click IBM WebSphere Eclipse Platform V3.01 (or whatever your old version

is).
4. Click the Uninstall button. A window containing a confirmation prompt opens.

Click Yes. If UAC is enabled, accept the Windows prompt to allow the uninstall
to run as elevated. The uninstall program then begins and runs to completion.
All the IBM WebSphere Eclipse Platform files are removed.

Unattended (silent) install and uninstall of IBM WebSphere
Eclipse Platform
About this task

The WebSphere Eclipse Platform can be installed either from the WebSphere MQ
installation launchpad or unattended (silently). To install from the WebSphere MQ
installation launchpad, see:“Installing and uninstalling IBM WebSphere Eclipse
Platform” on page 15.

WebSphere Eclipse Platform is installed using the Microsoft Installer (MSI). You
can invoke MSI directly, without using the WebSphere MQ Installation Launchpad.
This means that you can install WebSphere Eclipse Platform on a machine without
interaction. This process is called unattended (or silent) installation, and is
particularly useful for installing WebSphere Eclipse Platform over a network on a
remote machine, because you can install from a shared drive on a LAN server.
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The machine on which you want to install must be able to share the WebSphere
MQ Server CD, or a copy of the files on it, and you must be able to execute a
command on that machine.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

There are two ways to invoke MSI without using the WebSphere MQ installation
launchpad. These are:
v Using the msiexec command with command line parameters. See “Using

command line parameters with msiexec” on page 30.
v Using the msiexec command with a parameter that calls a response file. The

response file contains the parameters that you normally specify during an
interactive installation. See “Using a response file with msiexec” on page 33.

1. Insert the WebSphere MQ for Windows Server CD into the CD-ROM drive.
2. If autorun is enabled, cancel it at the first opportunity.
3. At the command line, enter the msiexec command.

Example

An example of a possible msiexec command for the silent installation of the
WebSphere Eclipse Platform is:
msiexec /q /i “D:\Prereqs\IES\MSI\IBM WebSphere Eclipse Platform V3.3.msi" /l*v
c:\install.log /m mif_file TRANSFORMS=1033.mst AGREETOLICENSE=“yes” ADDLOCAL=“All”

To install the WebSphere Eclipse Platform to a non-default directory, use the
following parameter:
TARGETDIR="<dir>"

where <dir> is the name of the non-default directory where you need to install the
WebSphere Eclipse Platform.

For further information on using the msiexec command for unattended installation,
please see: “Installing using msiexec” on page 28

What to do next

If you no longer need WebSphere Eclipse Platform Version 3.01, you can remove it
after you have installed WebSphere Eclipse Platform Version 3.3.

WebSphere Eclipse Platform can be uninstalled using Add/Remove Programs or
Programs and Features.

An example of a possible msiexec command for the silent uninstallation of the
WebSphere Eclipse Platform Version 3.01 is:
msiexec /x “D:\Prereqs\IES\MSI\IBM WebSphere Eclipse Platform V3.0.1.msi" /qn

where D:\Prereqs\IES\MSI\IBM WebSphere Eclipse Platform V3.0.1.msi is the name
of the .msi file originally used to install the WebSphere Eclipse Platform Version
3.01.
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Optional server software

The following are options, not prerequisites. Minimum supported levels are shown,
later levels are supported unless otherwise stated.
v External transaction processing monitors

– IBM TXSeries® V6.0
– IBM TXSeries V6.1
– WebSphere Application Server, V5.1
– WebSphere Application Server, V6.0.2
– WebSphere Application Server, V6.1
– BEA Tuxedo, Version 9.1
– BEA WebLogic Server 9.1
– MTS/COM (at the same level as the operating system)

v Databases
– IBM DB2® Version 9.1 for Linux®, Unix and Windows
– IBM DB2 Version 9.5 for Linux, Unix and Windows
– Informix® Dynamic Server (IDS) Version V10 with Client SDK V2.90
– Informix Dynamic Server (IDS) Version V10.50 with Client SDK V2.91
– Oracle 10g Release 2
– Oracle 11g Release 1
– Sybase Adaptive Server Enterprise (ASE) V15 with Sybase SDK V15

Compilers for WebSphere MQ applications
A list of supported compilers for WebSphere MQ for Windows

The following software compilers are supported:
v C and C++:

– Microsoft Visual Studio C++ 2005 SP1
– Microsoft Visual Studio C++ .NET 2003

Note: If you compile your application using Microsoft Visual Studio on one
system, and then copy the application to another system that does not have
Microsoft Visual Studio installed, you must install Microsoft Visual Studio
redistributable package (vcredist) on the target system.

v .NET
– Microsoft Visual C++ .NET 2003
– Microsoft Visual C++ .NET 2005
– Microsoft Visual C# .NET 2003
– Microsoft Visual C# .NET 2005
– Microsoft Visual Basic .NET 2003
– Microsoft Visual Basic .NET 2005

v COBOL:
– IBM VisualAge® COBOL Enterprise V3.0.1
– Micro Focus Net Express Version 4.0
– Micro Focus Net Express Version 5.0

v Visual Basic:
– Microsoft Visual Basic, Version 6.0
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v JDK:
– 32-bit

- IBM Developer Kit for Windows, Java 2 Technology Edition V1.4.2.
- IBM Developer Kit for Windows, Java 2 Technology Edition V5.0 (SR1 or

above)
- IBM Developer Kit for Windows, Java 2 Technology Edition
- Java 2 Platform, Standard Edition V1.4.2 from Sun Microsystems, Inc.
- Java 2 Platform, Standard Edition V5.0 (SR1 or above) from Sun

Microsystems, Inc.
- Java 2 Platform, Standard Edition V6.0 from Sun Microsystems, Inc.

– 64-bit
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 1.4.2
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 5.0
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 6.0
- Sun Java 2 Platform Standard Edition, Version 5.0

For latest details, see the WebSphere MQ product family Web site at:

http://www.ibm.com/software/integration/mqfamily

WebSphere MQ features

You can select the features that you require when you install WebSphere MQ. The
features shown below are available when you install WebSphere MQ from the
Server CD; for information on the features that are available on the WebSphere MQ
Client CD, see “WebSphere MQ client features” on page 79.

Server The server feature allows you to run queue managers on your computer
and connect to other computers over a network.

Server File Transfer
The Server File Transfer Application allows you to send and receive
ordinary files in the form of WebSphere MQ messages. You can use the
Server File Transfer Application to send and receive any type of file in any
format, for example: ASCII Linux format (with line feed characters), ASCII
file Windows format (with carriage return/line feed characters), binary (for
example, image files, wordprocessor files, spreadsheet files, or zip files),
also reports, letters, memos and charts. The Server File Transfer
Application has both a graphical user interface and a command line
interface.

MQ Explorer
The Explorer allows you to administer and monitor resources in
WebSphere MQ.

Windows client
The WebSphere MQ client is a small subset of WebSphere MQ, without a
queue manager, that uses the queue manager and queues on other (server)
computers. It can be used only when the computer it is on is connected to
another computer that is running a full server version of WebSphere MQ.
The client and the server can be on the same computer if required.

Chapter 4. Installing the WebSphere MQ Server 19

http://www.ibm.com/software/integration/mqfamily


Client Extended Transaction Support
A WebSphere MQ extended transactional client is a WebSphere MQ client
with some additional function. This function allows a client application,
within the same unit of work:
v To put messages to, and get messages from, queues that are owned by

the queue manager to which it is connected.
v To update the resources of a resource manager other than a WebSphere

MQ queue manager.

Client File Transfer
The Client File Transfer Application allows you to send and receive
ordinary files in the form of WebSphere MQ messages. You can use the
Client File Transfer Application to send and receive any type of file in any
format, for example: ASCII Linux format (with line feed characters), ASCII
file Windows format (with carriage return/line feed characters), binary (for
example, image files, wordprocessor files, spreadsheet files, or zip files),
also reports, letters, memos and charts. The Client File Transfer Application
only has a command line interface.

Java™ Messaging and Web Services
The files needed for messaging using Java (includes Java Message Service
support) and WebSphere MQ Web Services.

Java Extended Transaction Support
Extended transaction support for Java Message Service.

Development Toolkit
This feature includes sample source files, and the bindings (files .H, .LIB,
.DLL, and so on), that you need to develop applications to run on
WebSphere MQ. Bindings and samples are provided for the following
languages: C, C++, Visual Basic, ActiveX, Cobol, and .NET (including C#).
Java and Java Message Service support is included and samples are
provided for MTS (COM+), and MQSC.

Prerequisites for WebSphere MQ for Windows features
Certain features of WebSphere MQ require specific software in order to run.

The following table shows the prerequisite software for running each of the
WebSphere MQ features, and also the installation options used to install the
features:

Table 2. Prerequisites and installation options for WebSphere MQ features

WebSphere MQ feature Interactive installation
option

Prerequisites

Server v Typical

v Compact

v Custom

v None

Server File Transfer v Custom v For the graphical user interface:
WebSphere Eclipse Platform
Version 3.3

MQ Explorer v Typical

v Custom

v WebSphere Eclipse Platform
Version 3.3

Windows client v Custom v None
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Table 2. Prerequisites and installation options for WebSphere MQ features (continued)

WebSphere MQ feature Interactive installation
option

Prerequisites

Client Extended
Transaction Support

v Custom v None

Client File Transfer v Custom v For the graphical user interface:
WebSphere Eclipse Platform
Version 3.3

Java Messaging and Web
Services

v Typical

v Custom

v None

Java Extended
Transaction Support

v Custom v None

Development Toolkit v Typical

v Custom

v None

Note: The File Transfer Application can be installed from the Server CD for either
a Client or a Server.

Accessibility

The WebSphere MQ user interfaces do not use any special keys, but instead follow
the Windows user interface guidelines for accelerator keys on items such as context
menus, dialogs, and dialog controls such as buttons. Access the accelerator keys in
the usual way. See the Windows help for more information (look in the Windows
help index for keyboard; for accessibility features look for Accessibility).

Special features for accessibility

Some of the user interfaces in WebSphere MQ are normally visual, but they behave
differently when accessibility features are activated, as follows:
v High Contrast Mode

In this mode Launchpad, Prepare WebSphere MQ Wizard, Postcard, and Default
Configuration all hide their background bitmaps and ensure that they use the
system text colors so that they are easily visible and readable.

v Screen Reader Mode
When a screen reader is active, Prepare WebSphere MQ Wizard, Default
Configuration, Postcard, and API Exerciser, simplify their appearance by hiding
background bitmaps, raised effects, shadow boxes, and other effects that can
otherwise confuse the screen reader.
Additionally, API Exerciser, when the result of doing an API call is added to the
list in the window, pops up a message box, so that the screen reader reads it to
the user.

v Explorer Object Status
The Explorer component of WebSphere MQ uses icons to indicate the status of
objects, such as queue managers. Screen readers cannot interpret these icons, so
there is an option to show a textual description of the icon. To select this option,
from within the Explorer click Window → Preferences → WebSphere MQ
Explorer and select Show status of objects after object name.
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WebSphere MQ Server installation methods

This section provides guidance on how to install WebSphere MQ for Windows. If
you are migrating from an earlier version of WebSphere MQ, see Chapter 1,
“Migrating to WebSphere MQ for Windows Version 7.0,” on page 1. To modify an
existing installation, see “Modifying your installation” on page 49. If you are
installing a WebSphere MQ client see Chapter 5, “Installing the WebSphere MQ
Client,” on page 75

WebSphere MQ is typically installed interactively using the WebSphere MQ
Installation Launchpad graphical user interface. For instructions for interactive
installation using the Launchpad see “Installing using the launchpad”

Note: When installing using a Remote Desktop Connection, you might need to
logoff, then re-logon to pick up the changes made to your environment by the
installation process.

For all of the following installation methods, installing with a custom location such
as C:\Users for Windows Vista or C:\Documents and Settings for Windows XP
and Windows 2003 Server is not supported.

WebSphere MQ can also be installed using the following methods:
v From a LAN, see “Installing from a LAN” on page 27
v Unattended (silently), see “Unattended (silent) installation” on page 28
v Using msiexec, see “Installing using msiexec” on page 28
v Using Microsoft System Management Server (SMS), see “Installing with

Microsoft System Management Server” on page 48

User Account Control (UAC) on Windows Vista and Windows
Server 2008

Windows Vista and Windows Server 2008 introduce a User Account Control (UAC)
feature, which restricts the actions users can perform on certain operating system
facilities, even if they are members of the Administrators group.

UAC is enabled by default on Windows Vista and Windows Server 2008. This
means installing WebSphere MQ on Windows Vista or Windows Server 2008
differs from installing WebSphere MQ on previous versions of Windows. At certain
points during installation, migration, and uninstallation, you must manually accept
the Windows UAC prompt to allow processes to run with elevated authority.
During silent installation and uninstallation, you must invoke the process from an
elevated command prompt. The points when you have to accept the Windows
prompt for UAC or invoke processes from an elevated command prompt have
been flagged in the specific topics affected.

Installing using the launchpad
Before you install, you must decide what type of installation you require. Table 3
on page 23 shows the installation types available, and the features that are
installed with each option. For the prerequisites required for each feature, see
“Prerequisites for WebSphere MQ for Windows features” on page 20.
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Table 3. Features installed with each type of installation

Installation
type

Features installed Comments

Typical v Server

v MQ Explorer

v Development Toolkit

v Java Messaging and Web Services

The default option. Features are
installed to default locations.

Compact v Server only The server is installed to the default
location.

Custom By default, the following features are
preselected:

v Server

v MQ Explorer

v Development Toolkit

v Java Messaging and Web Services

A custom installation can also install:

v Windows client

v Server File Transfer

v Client File Transfer

v Client Extended Transaction
Support

v Java Extended Transaction Support

This method must be used if you
want to install the Windows client.All
the available features are listed and
you can select which ones to install,
and where to install them.

The installation types are:
v Typical installation
v Compact installation
v Custom Installation

For instructions on all these installation types see “Launchpad instructions.”

After installation, WebSphere MQ must be configured, see “Configuring
WebSphere MQ with the Prepare WebSphere MQ wizard” on page 52.

WebSphere MQ Installation Launchpad can also be used for modifying a current
WebSphere MQ installation, to modify an installation using:
v WebSphere MQ Installation Launchpad, see “Modifying the installation using

WebSphere MQ Installation Launchpad” on page 49.
v Add/Remove Programs, see “Modifying the installation using Add/Remove

Programs” on page 50.

Launchpad instructions
About this task

These instructions cover using the launchpad to make a compact, typical or custom
installation of the WebSphere MQ server. To view all the installation types and the
features that are installed with each option consult Table 3.
1. Insert the WebSphere MQ for Windows Server CD into the CD-ROM drive.
2. If autorun is enabled, the installation process starts.

Otherwise, double-click the Setup icon in the root folder of the CD to start the
installation process.
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If you are installing on Windows Vista or Windows Server 2008 and UAC is
enabled, accept the Windows prompt to allow the launchpad to run as
elevated. During installation you might also see Open File - Security Warning
dialog boxes that list International Business Machines Limited as the
publisher. Click Run to allow the installation to continue.
The WebSphere MQ Installation Launchpad window is displayed.

3. Click the Software Prerequisites option.

The window (shown in Figure 1) lists the prerequisite software for a typical
installation. To the right of each installation item there is either the word
“OK” if the software is installed, or the words “Not Installed” if the software
is not installed.
If the words “Not Installed” are displayed:
a. Click the + symbol to the left of the item to display installation links. For

specific information on how to install WebSphere Eclipse Platform see
“Installing and uninstalling IBM WebSphere Eclipse Platform” on page 15.

b. Select the option for the installation source you want to use. Select from:
v CD-ROM
v Network

Note: Some software prerequisites are not available from all sources.
c. When installation is complete, click the Refresh button.

4. Click Network Configuration. This panel describes the conditions under
which WebSphere MQ needs a special domain account.
v If the conditions described in the window apply, select Yes. If you do not

have details of the required special domain account, follow the More
Information link or ask your domain administrator. Further information is

Figure 1. Launchpad Software Prerequisites page
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also available in “Configuring WebSphere MQ accounts” on page 57. You
cannot continue to install WebSphere MQ until you have details of the
special domain account.

v If the conditions described do not apply, click No.
v If you do not know, click the Don’t know option, or contact your domain

administrator.
5. When you have clicked Yes (and have details of the special domain account),

or if you clicked No, click the Migrating SSL certificates option. This window
describes the conditions under which you need to check the SSL certificate
chain for your queue managers or clients. If you do not have WebSphere MQ
Version 5.3 installed these options will not be available, go to step 6.
v If the conditions described in the window apply, click Yes. You must now

ensure that the SSL certificates used to authenticate queue managers or
clients on this computer have full certificate chains in the WebSphere MQ
certificate store. WebSphere MQ can check your stores for you. To do this,
run the Check WebSphere MQ Certificate Stores Wizard.

v If the conditions described do not apply, click No.
v If you do not know, click the Don’t know option, or follow the More

Information link.
6. When you have clicked Yes (and have ensured you have full certificate

chains), or if you clicked No, click the WebSphere MQ Installation option.
The WebSphere MQ Installation panel is displayed with a summary of the
pre-installation status.

7. To continue, click Launch IBM WebSphere MQ Installer, and wait until the
WebSphere MQ Setup window is displayed with a welcome message.

8. If the current version of WebSphere MQ is already installed, the Program
Maintenance panel is displayed with two options: Modify and Remove.
v If you select Modify, click Next, then see “Modifying the installation using

WebSphere MQ Installation Launchpad” on page 49 from step 7 on page 49
onwards.

v If you select Remove, click Next, then see “Uninstalling WebSphere MQ
using the installation process” on page 99 from step 6 on page 99 onwards.

If the current version of WebSphere MQ is not installed, the License
Agreement panel is displayed.

9. Read the information on the panel. Click the Licence Terms button to read the
license terms.
To change the language that the license agreement is displayed in, click
Change Language, then select the language you require from the list
provided.
Select the option to accept the license terms, then click Next.

10. If there is a previous version of this product installed on the machine, go to
step 18 on page 27.
If there is no previous version of this product installed the Setup Type panel is
displayed. At this panel you can chose to perform a compact, typical, or
custom installation. For more information about the features installed by each
of these types of installation see Table 3 on page 23.
v For a compact installation, select Compact on the Setup Type window, then

click Next. Go to step 18 on page 27.
v For a typical installation, select Typical on the Setup Type window, click

Next. Go to step 18 on page 27.
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v For a custom installation, Select Custom on the Setup Type window, click
Next. Go to step 11.

11. The Destination Folder panel for program files is displayed.
v To accept the default folder for the program files, click Next.
v To change the folder for the program files, click Change, select the required

folder from the dialog box, click OK, then click Next.
12. Next the Destination Folder panel for data files is displayed.

v To accept the default folder for the data files, click Next.
v To change the folder for the data files, click Change, select the required

folder from the dialog box, click OK, then click Next.
13. Next the Destination Folder panel for the Global Security Kit is displayed. If

the Global Security Kit is already installed this panel will not be displayed.
v To accept the default folder for the Global Security Kit, click Next.
v To change the folder for the Global Security Kit, click Change, select the

required folder from the dialog box, click OK, then click Next.
14. Next the Destination Folder panel for log files is displayed.

v To accept the default folder for the log files, click Next.
v To change the folder for the log files, click Change, select the required

folder from the dialog box, click OK, then click Next.
15. The Features panel is displayed (see Figure 2). This is where you choose

which features you wish to install (including the Client feature).

To change the installation of a feature:
a. Click the symbol to the left of the feature name to display a drop-down

menu.
b. Select the required option from:
v Install this feature
v Install this feature and all its subfeatures (if any)
v Do not install this feature (remove if already installed)

Figure 2. Setup features panel
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c. The symbol to the left of the feature name changes to show the current
installation option. For more information, click Help to display the Custom
Setup Tips page, which explains the icons used in the feature list.

16. Optional: To check that there is enough disk space, click Space. The Disk
Space Requirements panel is displayed. This shows the disk space available
and the amount of disk space that your current selections will take. It
highlights any volumes that do not have enough disk space.
To close the panel and return to the Features panel, click OK.

17. When your selections are complete, click Next.
18. The WebSphere MQ Setup window displays the following message:

Ready to Install WebSphere MQ

The window also displays a summary of the installation that you selected.
To continue, click Install.

19. Wait until the progress bar is complete. This might take several minutes.
When WebSphere MQ is successfully installed, the WebSphere MQ Setup
window displays the following message:
Installation Wizard Completed Successfully

20. Click Finish to launch the Prepare WebSphere MQ wizard.
21. Follow the procedure described in “Configuring WebSphere MQ with the

Prepare WebSphere MQ wizard” on page 52

Note: When installing using a Remote Desktop Connection, you might need
to logoff, then re-logon to pick up the changes made to your environment by
the installation process.

Installing from a LAN
About this task

There are two ways to put WebSphere MQ installation files on a LAN server for
easier access:
v You can make the WebSphere MQ Server CD-ROM drive shareable
v You can copy the installation files from the CD to a server. To do this, use the

following steps:
1. Create a folder on the LAN server to store the installation files. For example:

md m:\instmqs

2. Load the WebSphere MQ Server CD. If autorun is enabled, the WebSphere
MQ Installation Launchpad window is displayed. Select Cancel to close this
window.

3. Copy the entire CD to the installation folder. For example:
xcopy e:\*.* m:\instmqs /e

4. Give all licensed users access to the folder that now contains the CD image.
In this example, users need access to the m: drive.

5. From a remote machine:
a. Map the shared resource to a drive letter. You can use the net use

command, or Windows Explorer.
b. Change to the installation folder.
c. Type setup, then press Enter.
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Results

The WebSphere MQ Launchpad is now launched.

What to do next

Follow the installation instructions given in “Installing using the launchpad” on
page 22 to install WebSphere MQ using the Launchpad.

Unattended (silent) installation
WebSphere MQ for Windows is installed using the Microsoft Installer (MSI). You
can invoke MSI directly, without using the WebSphere MQ Installation Launchpad.
This means that you can install WebSphere MQ on a machine without interaction.
This process is called unattended (or silent) installation, and is particularly useful
for installing WebSphere MQ over a network on a remote machine, because you
can install from a shared drive on a LAN server.

The machine on which you want to install must be able to share the WebSphere
MQ Server CD, or a copy of the files on it, and you must be able to execute a
command on that machine. The silent install methods assume that you have
already installed any prerequisites for the features you plan to install. For a list of
the prerequisites required for each feature, see Table 2 on page 20. The
prerequisites can be installed in the setup panels of the Launchpad, see
“Launchpad instructions” on page 23 for more information on how to do this.

If the prerequisite software is not installed and the silent installation includes the
WebSphere MQ Explorer feature, installation will fail. If this happens, any failures
or warnings are shown in the installation log files.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

There are several ways to invoke MSI without using the WebSphere MQ
installation launchpad. These are:
v Using the msiexec command with command line parameters. See “Using

command line parameters with msiexec” on page 30.
v Using the msiexec command with a parameter that calls a response file. The

response file contains the parameters that you normally specify during an
interactive installation. See “Using a response file with msiexec” on page 33.

v Use the MQParms command with command line parameters, a parameter file, or
both. The parameter file can contain many more parameters than a response file.
See “Using the MQParms command” on page 41.

Also, you can use Microsoft System Management Server to install WebSphere MQ.
See “Installing with Microsoft System Management Server” on page 48.

Installing using msiexec
About this task

The msiexec command uses parameters to give MSI some or all of the information
that would normally be specified as part of an interactive installation using
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WebSphere MQ Installation Launchpad. This means a user can create a reusable
automated or semi-automated installation configuration. Parameters can be given
through the command line, a transform file, a response file, or a combination of the
three.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke a silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

To install using msiexec, follow the instructions below:

At the command line enter the msiexec command in the following format:
msiexec parameters USEINI="response-file" TRANSFORM="transform_file"
Where:

parameters
are either command line parameters preceded by a / character, or
property=value pairs (if using both forms of parameter always put the
command line parameters first). For further information see “Using
command line parameters with msiexec” on page 30.

Note: You must include the /i parameter and the file location of the
WebSphere MQ installer package.

response-file
is the full path and file name of the file that contains the [Response] stanza
and the required property=value pairs, for example C:\MyResponseFile.ini.
An example response file, Response.ini, is supplied with WebSphere MQ.
This file contains default installation parameters. For further information
see “Using a response file with msiexec” on page 33.

transform_file
is the full path and filename of a transform file. For further information see
“Using transforms with msiexec” on page 39.

Results

After the command has been entered, the command prompt will immediately
reappear. WebSphere MQ will be installing as a background process. If you have
entered parameters to produce a log, check this file to see how the install is
progressing. If the install completes successfully you will see the message
Installation operation completed successfully in the log file.

You can also use the Windows Task Manager to see when the msiexec process has
completed.

Note: If you install WebSphere MQ using msiexec you must first end any
applications that are using Java. This is because if a Java application is running,
WebSphere MQ will be unable to update the class path. If WebSphere MQ is
unable to update the class path, your computer will restart to allow the update to
happen.
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Using command line parameters with msiexec

You can use the msiexec command with command line parameters to invoke
installation or uninstallation. The msiexec command uses parameters to give MSI
some or all of the information that would normally be specified as part of an
interactive installation using the WebSphere MQ Installation Launchpad. To do
this, enter the following command at a command line, followed by the parameters
you require:
msiexec [parameters]

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke a silent installation or
silent uninstallation from an elevated command prompt. Elevate a command
prompt by using a right-click to start the command prompt and choose Run as
administrator. If you try to silently install or uninstall from a non-elevated
command prompt, the install or uninstall fails with an error of AMQ4353 in the
install log.

The msiexec command can accept two types of parameters on the command line,
these are:
v Standard command line parameters, preceded by a / character.

For an unattended (silent) installation, include the /q or /qn parameter in the
command line, and set the AGREETOLICENSE parameter to ″yes″. For
information on what an unattended installation is, see “Unattended (silent)
installation” on page 28.
For a table of the msiexec command line parameters, see Table 4 on page 31.

v Property=value pair parameters on the command line. All the parameters
available for use in a response file can be used on the command line, for a list of
these see Table 6 on page 34. In addition there are some extra property=value
pair parameters that are only for use on the command line, for details of these
see Table 5 on page 33.
When using the property=value pair parameters note that:
– Property strings must be in upper case.
– Value strings are not case-sensitive, except for feature names. You can enclose

value strings in double quotation marks. If a value string includes a blank,
enclose the blank value string in double quotation marks.

– For a property that can take more than one value, use the format:
ADDLOCAL="Server,Client"

When using property=value pair and command line parameters with the msiexec
command, enter command line parameters first.

If a parameter is specified both on the command line and in a response file, the
setting on the command line takes precedence.

A typical example of an msiexec command is:
msiexec /i “path\MSI\IBM WebSphere MQ.msi” /l*v c:\install.log /m mif_file

TRANSFORMS=“1033.mst” AGREETOLICENSE=“yes” ADDLOCAL=“Server”

where:

/i “path\MSI\IBM WebSphere MQ.msi”
Install the product using the .msi specified.
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/l*v c:\install.log
Produce a log file called install.log, containing all information in verbose
format.

/m mif_file
Generate a Microsoft System Management Server (SMS) status .mif file
called mif_file.

TRANSFORMS=“1033.mst”
Specifies that the installation is in U.S. English. For further information
about installing in different national languages, see “Using transforms with
msiexec” on page 39.

AGREETOLICENSE=“yes”
Accept the terms of the license.

ADDLOCAL=“Server”
Install the server feature locally.

Parameters

The msiexec command can take further parameters that are not supported or listed
here. If you need details of these, refer to the help file for the Windows Installer
that is supplied with the MSI software development kit. See the Microsoft Web site
at:

http://www.microsoft.com

Table 4. msiexec command line parameters

Parameter Options Description

/a Package Installs a product on the network using
administrative installation, that is,
installs a source image of the application
onto the network that is similar to a
source image on a CD.

/i Package|ProductCode Installs or configures a product using the
specified .msi file.

The WebSphere MQ Windows Installer
package is IBM WebSphere MQ.msi.

/j
[u|m]Package|
[u|m]Package /t TransformList|
[u|m]Package /g LanguageID

Advertises the product.

This option ignores any property values
entered on the command line.
u Advertise to the current user
m Advertise to all users of this

machine
g Language ID
t Applies transform to advertised

package
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Table 4. msiexec command line parameters (continued)

Parameter Options Description

/l
[i|w|e|a|r|u|c|m|o|p
|v|+|!]Logfile

Specifies path to log file, with flags to
set which information to log.
i Status messages
w Recoverable warnings
e All error messages
a Startup of actions
r Action-specific records
u User requests
c Initial user interface parameters
m Out-of-memory or

unrecoverable exit information
o Out-of-disk-space messages
p Terminal properties
v Verbose output
+ Append to existing file
! Flush each line to the log
* Log all information except for

the v option. To log all
information including the v
option, specify ″/l*v″

/q n|b|r|f Sets the level of user interface displayed
during the install.
q, qn No user interface. A silent

installation that displays no
user interface.

qb Basic user interface. Displays
the built-in dialog boxes that
show progress messages

qr Reduced user interface with a
modal dialog box displayed at
the end of the installation.

qf Full user interface with a modal
dialog box displayed at the end.

qn+ No user interface except for a
modal dialog box displayed at
the end of installation.

qb+ Basic user interface with a
modal dialog box displayed at
the end. The modal box is not
displayed if the user cancels the
installation.

qb- Basic user interface with no
modal dialog boxes. Note that
/qb+- is not a supported UI
level.

/x Package|ProductCode Uninstalls the product.

Note:

1. Do not use the options /i, /x, /j[u|m], and /a together.

2. Use the options /t and /g only with /j.

3. Use the options /l and /q with /i, /x, /j[u|m], and /a.

Table 6 on page 34 and Table 5 on page 33 show the parameters that you can enter
as property=value pairs on the msiexec command line (defaults are shown in
bold). Use the parameters given in Table 5 on page 33 on the command line only,
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and not in a response file.

Table 5. msiexec property=value parameters

Property Values Meaning

USEINI path\file_name Use the specified response file. See “Using a
response file with msiexec.”

SAVEINI path\file_name Generate a response file during installation. The
file contains those parameters selected for this
installation that a user might make during an
interactive installation.

ONLYINI 1|yes|″″ 1, yes or any value other than null. End the
installation before updating the target system, but
after generating a response file, if this is
specified.

″″. Continue the installation and update the
target machine (the default).

TRANSFORMS path\file_name Species what transform (.mst) files should be
applied to the product. For example, "1033.mst"
specifies the supplied U.S. English transform file.

Using a response file with msiexec

You can use the msiexec command with a parameter call that calls a response file.
The response file contains the parameters that you normally specify during an
interactive installation. You can combine the msiexec command line parameters
described in “Using command line parameters with msiexec” on page 30 with a
response file to invoke a complex installation or uninstallation. This could be silent
or interactive. For a silent installation, this must include the /q or /qn parameter.

Running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control enabled

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, there are some extra limitations:
v You must invoke a silent installation from an elevated command prompt. Elevate

a command prompt by using a right-click to start the command prompt and
choose Run as administrator. If you try to silently install from a non-elevated
command prompt, the install fails with an error of AMQ4353 in the install log.

v If you choose to run the Prepare WebSphere MQ Wizard but you do not
complete the wizard directly after WebSphere MQ installs, or if for any reason
your machine is rebooted between completing WebSphere MQ installation and
completing the Prepare WebSphere MQ Wizard, ensure the wizard is run with
Administrator privilege, otherwise the wizard might fail.

v During an interactive installation accept the Windows prompt to allow the
launchpad to run as elevated. During installation you might also see Open File -
Security Warning dialog boxes that list International Business Machines Limited
as the publisher. Click Run to allow the installation to continue.

A response file is an ASCII text file, with a format similar to a Windows .ini file,
that contains the stanza [Response]. The [Response] stanza contains some or all of
the parameters that would normally be specified as part of an interactive
installation using the WebSphere MQ Installation Launchpad. The parameters are
given in a property=value pair format. Any other stanzas in the response file are
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ignored by msiexec. An example response file, Response.ini, is supplied with
WebSphere MQ. It contains the default installation parameters.

Using the msiexec command

To invoke the msiexec command using a response file, enter the following
command at a command line:
msiexec [parameters] USEINI=“response_file”

Where:

parameters
are any of the command line parameters listed in table Table 4 on page 31,
or property=value pairs listed in tables Table 5 on page 33 and Table 6 on
the command line. Command line parameters should always be entered
before property=value pairs.

response_file
is the full path and file name of the file that contains the [Response] stanza
and the required property=value pairs, for example C:\MyResponseFile.ini.

If a parameter is specified both on the command line and in a response file, the
setting on the command line takes precedence.

In the response file, all text is in English, and comments begin with a ; character.

For information on creating a response file see “Creating a response file” on page
37.

Parameters

Table 6 shows the parameters that you can enter in the response file (defaults are
shown in bold). Some properties or values are related to uninstallation, rather than
installation. Note that:
v Property strings must be in upper case.
v Value strings are not case sensitive, except for feature names. They can be

enclosed in double quotation marks. If a value string includes a blank or a
comma, it must be enclosed in double quotation marks.

v For a property that can take more than one value, use the format:
ADDLOCAL="Server,Client"

Table 6. Response file parameters

Property Values Meaning

PGMFOLDER path Folder for the WebSphere MQ program files. For
example, c:\mqm.

DATFOLDER path Folder for the WebSphere MQ data files. For
example, c:\mqm\data.

LOGFOLDER path Folder for the WebSphere MQ queue manager
log files. For example, c:\mqm\log.

GSKFOLDER path Folder for the Global Security Kit files.
WebSphere MQ will append IBM\gsk7 to the path
given for this parameter. For example, if you set
GSKFOLDER=“c:\Program Files”, the Global
Security Kit files will be stored in c:\Program
Files\IBM\gsk7.
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Table 6. Response file parameters (continued)

Property Values Meaning

USERCHOICE 0|no If the command line or response file specifies
parameters to install features, a dialog can be
displayed to prompt the user to accept the
preselected options, or review and possibly
change them.

0 or no. Suppresses display of the dialog.

Anything else. Dialog is displayed.

Not used for a silent installation.

AGREETOLICENSE yes Accept the terms of the license. For a silent
installation, this must be set to yes.

If the installation is not silent, this parameter is
ignored.

KEEPQMDATA keep |delete If the Server feature is to be uninstalled, whether
to delete any existing queue managers.

delete removes any existing queue managers.

keep, or any other value, keeps them.

KEEPWEBDATA keep|delete If the WebAdmin feature is already installed from
a previous version of WebSphere MQ, it will be
uninstalled. This property gives you the option to
delete the existing Web Administration scripts.

delete removes any existing Web Administration
scripts.

keep, or any other value, keeps them.

LAUNCHWIZ 0|1|yes|no|″″ 0 or no. Do not launch the Prepare WebSphere
MQ wizard after WebSphere MQ is installed.

1 or yes. Launch the Prepare WebSphere MQ
wizard if the Server feature is installed.

″″. Launch the Prepare WebSphere MQ wizard if
this installation will install the Server (the
default).

If this option will launch the Prepare WebSphere
MQ wizard, you can specify the WIZPARMFILE,
either in this file, or on the command line.

The Prepare WebSphere MQ Wizard must be run
to make your WebSphere MQ installation
operational. If you choose not to launch it here,
you must run it before using WebSphere MQ.

WIZPARMFILE path\file_name When specified, the file that contains the
parameters to pass to the Prepare WebSphere MQ
wizard when it is launched. These are in the
[Services] and [SSLMigration] stanzas. See Table 9
on page 40.
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Table 6. Response file parameters (continued)

Property Values Meaning

ADDLOCAL feature, feature,
|All|″″

A comma-separated list of features to install
locally. For a list of valid feature names, see
Table 7 on page 37.

All installs all features

″″ installs the typical features. If you do not want
a feature use REMOVE=″feature″
Note: If this is a new installation the typical
features (Server, Explorer, Java Messaging and
SOAP Transport, and Development Toolkit) are
installed by default irrespective of the feature list
provided in the ADDLOCAL property. If you do
not want a feature use REMOVE=″feature″

REMOVE feature, feature,
|All|″″

A comma-separated list of features to remove.
For a list of valid feature names, see Table 7 on
page 37.

All uninstalls all features

″″ uninstalls no features (the default).

REMOVEFEATURES 1|yes Must be set to 1 or yes for a silent installation if
Internet Gateway, Web Administration Server, or
SupportPac MA88 are installed, or the installation
fails.

STARTSERVICE 0|no|″″ 0 or no. Do not start the WebSphere MQ Service
at the end of installation.

″″ (the default). Start the WebSphere MQ Service
at the end of installation if it was running at the
start, or if this is a new installation.

Anything else. Start the Service at the end of the
installation.

Ignored if the server feature is not installed.

If you do not start the WebSphere MQ Service,
WebSphere MQ will not be operational and
queue managers will not start. You must run the
Prepare WebSphere MQ wizard for the service to
be correctly configured.

STARTTASKBAR 0|no|″″ 0 or no. Do not start the WebSphere MQ taskbar
application at the end of installation.

″″ (the default). Start the WebSphere MQ taskbar
application at the end of installation if it was
running at the start, or if this is a new
installation.

Anything else. Start the taskbar application at the
end of the installation.

Ignored if the server feature is not installed.
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Table 6. Response file parameters (continued)

Property Values Meaning

HIGHCONTRAST 0|no|″″ 0 or no. Do not set high-contrast mode for the
installation.

″″ (the default). Set high-contrast mode for the
installation if Windows 2003 or Windows XP
high-contrast mode is set or if WebSphere MQ
high-contrast mode is set.

Anything else. Set high-contrast mode for the
installation.

Table 7 shows the features that can be values for the ADDLOCAL and REMOVE
properties.

Table 7. Valid feature names

Feature Name Description

Server The WebSphere MQ for Windows server. This will install the files
needed to create and run queue managers.

FTA_Server The file transfer application for the server. This is a graphical
application used to send and receive files.

Explorer The WebSphere MQ Explorer.

This feature is installed automatically if the server feature is
installed. You can select to remove it.

Client The WebSphere MQ for Windows client.

XA_Client Extended transaction support for the Windows client.

FTA_Client The file transfer application for the client. This is a graphical
application used to send and receive files.

JavaMsg The files needed for messaging using Java (includes Java Message
Service and SOAP transport support).

XA_Java Extended transaction support for Java Message Service.

Toolkit Sample WebSphere MQ program source, sample executable code,
headers, and bindings.

An example of a typical response file:
[Response]
PGMFOLDER="c:\mqm"
DATFOLDER="c:\mqm\data"
LOGFOLDER="c:\mqm\log"
GSKFOLDER="c:\mqm"
AGREETOLICENSE="yes"
LAUNCHWIZ=""
WIZPARMFILE="d:\MQParms.ini"
ADDLOCAL="Server,Client"
REMOVE="Toolkit"

Creating a response file:

A response file is used with msiexec. You can create it in three ways.
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About this task

A response file is used with the msiexec command, for further information see
“Using a response file with msiexec” on page 33.

There are three ways to create a response file for installation:
v Copy and edit the file Response.ini that is supplied on the WebSphere MQ

Windows Server CD, using an ASCII file editor.
v Create your own response file using an ASCII file editor.
v Use the msiexec command with the SAVEINI (and optionally, the ONLYINI)

command line parameters to generate a response file that contains the same
installation options. See Table 5 on page 33.

Example

A typical example of using msiexec with the SAVEINI parameter is here:
msiexec /i "path\IBM WebSphere MQ.msi" /q SAVEINI="response_file"
TRANSFORMS="1033.mst" AGREETOLICENSE="yes"

Installing silently using msiexec with a response file
How to install WebSphere MQ without interaction.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

For an unattended (silent) installation you must include the /q or /qn parameter
when entering msiexec at the command line. You must also set the
AGREETOLICENSE parameter to ″yes″ for a silent install. To install silently using
the msiexec command, do the following:

At the command line enter the msiexec command in the following format:
msiexec /i "path\IBM WebSphere MQ.msi" /q USEINI="response_file"
TRANSFORMS="1033.mst"

where:

/q Specifies a silent installation.

response_file
Is the full path name of the file that contains the [Response] stanza and the
required property=value pairs, for example C:\MyResponseFile.ini. An
example response file, Response.ini, is supplied with WebSphere MQ. This
file contains default installation parameters.

TRANSFORMS=″1033.mst″
Specifies that the installation is in U.S. English. For further information
about installing in different national languages, see “Using transforms with
msiexec” on page 39.

You can also specify property=value pairs on the command line (the property must
be in upper case), for example:
msiexec /i "path\IBM WebSphere MQ.msi" /q USEINI="C:\MyResponseFile.ini"
TRANSFORMS="1033.mst" AGREETOLICENSE="yes"
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If a parameter is specified both on the command line and in the response file, the
setting on the command line takes precedence.

Using transforms with msiexec
This lists the local identifier, language, and the transform file name to use in the
msiexec command line, to support different national languages.

MSI can use transforms to modify an installation. During WebSphere MQ
installation, transforms can be used to support different national languages.
WebSphere MQ is supplied with transform files in the \MSI folder of the Server
CD. These files are also embedded in the WebSphere MQ Windows installer
package, IBM WebSphere MQ.msi.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke a silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

On the msiexec command line, you can specify the required language by using the
TRANSFORMS property in a property=value pair. The quotes surrounding the
value are optional. For example:
TRANSFORMS="1033.mst"

You can also specify the full path and file name of the transform file. Again, the
quotes surrounding the value are optional. For example:
TRANSFORMS="D:\Msi\1033.mst"

Table 8 shows the locale identifier, language, and the transform file name to use in
the msiexec command line. For a list of the msiexec property=value parameters,
see Table 5 on page 33.

Note: When you use a property=value pair and command line parameters with
the msiexec command, enter command line parameters first.

You can also specify the required language by using the MQLANGUAGE property
with the MQParms command. For information about the msiexec property=value
parameters, see Table 10 on page 44.

Parameters

Table 8. Supplied transform files. This table shows the supplied transform files, the resulting
language, and the numerical value to use in the msiexec command line.

Language Transform File name Value

U.S. English 1033.mst 1033

German 1031.mst 1031

French 1036.mst 1036

Spanish 1034.mst 1034

Italian 1040.mst 1040

Brazilian Portuguese 1046.mst 1046

Japanese 1041.mst 1041

Korean 1042.mst 1042
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Table 8. Supplied transform files (continued). This table shows the supplied transform files,
the resulting language, and the numerical value to use in the msiexec command line.

Language Transform File name Value

Simplified Chinese 2052.mst 2052

Traditional Chinese 1028.mst 1028

Czech 1029.mst 1029

Russian 1049.mst 1049

Hungarian 1038.mst 1038

Polish 1045.mst 1045

Startup parameters for Prepare WebSphere MQ wizard

Note: For Windows Vista and Windows Server 2008 users with UAC enabled
only: if you do not complete the Prepare WebSphere MQ Wizard directly after
WebSphere MQ installs or if for any reason your machine is rebooted between
completing WebSphere MQ installation and completing the Prepare WebSphere
MQ Wizard, ensure the wizard is run with Administrator privilege, otherwise the
wizard might fail. You might also see Open File - Security Warning dialog boxes
that list International Business Machines Limited as the publisher. Click Run to
allow the wizard to continue.

The Prepare WebSphere MQ wizard (AMQMJPSE.EXE) accepts the following
optional parameters:

Table 9. Startup Parameters for Prepare WebSphere MQ Wizard

Parameter Name Description
Default action if parameter not
supplied

–l <file> Create log file The Prepare WebSphere MQ wizard
appends to a log file with the program
actions and results.

This parameter specifies the filename to
use for this log. If the path is not
provided, the WebSphere MQ Data
directory is assumed. If the filename is
not provided, AMQMJPSE.LOG is
assumed.

Append to log file
AMQMJPSE.LOG in WebSphere
MQ Data directory.

–r Reset
MQSeries®Service
user account

When the Prepare WebSphere MQ
wizard is first run it creates a local user
account MUSR_MQADMIN, with
specific settings and permissions. The
MQSeriesService component is
configured to run under this account.
Depending on the LAN configuration,
the wizard might reconfigure the
MQSeriesService component to run
under a domain user account instead.

When this parameter is specified, the
local user account MUSR_MQADMIN is
re-created with all the default settings
and permissions. The MQSeriesService
component is configured to run under
this account.

User account not reset.
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Table 9. Startup Parameters for Prepare WebSphere MQ Wizard (continued)

Parameter Name Description
Default action if parameter not
supplied

–s silent install mode Process silently. Nothing is displayed
and there is no user input.

Not silent mode.

–p <file> User parameters
from file

Load and use parameters from the
parameter file. If the path is not
provided, the WebSphere MQ Data
directory is assumed. If the filename is
not provided, AMQMJPSE.INI is
assumed.

For more information about the format
of this file see “MQParms parameter
file” on page 43. The following stanzas
are loaded:

[Services]
[SSLMigration]

When in silent mode, the parameter
file AMQJPSE.INI is loaded from
WebSphere MQ Data directory.

When not in silent mode, a
parameter file is not used.

–m <file> Generate a Microsoft
System Management
Server (SMS) status
.MIF file.

When the Prepare WebSphere MQ
wizard closes, generate a status .MIF
file with the specified name. If the path
is not provided, the WebSphere MQ
Data directory is assumed. If the
filename is not provided,
AMQMJPSE.MIF is assumed.

The file ISMIF32.DLL (installed as part
of SMS) must be in the path.

The InstallStatus field in the file will
contain either Success or Failed.

.MIF file not created.

Using the MQParms command
Before you begin

You can use the MQParms command to invoke installation or uninstallation. This
command can use parameters on a command line, or those specified in a
parameter file. The parameter file is an ASCII text file that contains the parameter
values that you want to set for the installation. The MQParms command takes the
specified parameters and generates the corresponding msiexec command line.

This means that you can save all the parameters that you want to use with the
msiexec command in a single file.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke a silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

For a silent installation, this must include the /q or /qn parameter, either on the
command line, or in the [MSI] stanza of the parameter file. You must also set the
AGREETOLICENSE parameter to ″yes″.
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You can specify many more parameters in the parameter file that you use with the
MQParms command than you can in the response file that you use directly with the
msiexec command. Also, as well as parameters that the WebSphere MQ installation
uses, you can specify parameters that can be used by the Prepare WebSphere MQ
wizard.

You can also run the MQParms program directly from the Windows Explorer by
clicking on the file icon in the list of file names. If you are running WebSphere MQ
on Windows Vista or Windows Server 2008 with User Account Control (UAC)
enabled, you must invoke the installation with elevated privileges by using a
right-click to start the program and selecting Run as administrator. If you try to
run the MQParms program without using elevated privileges, the install fails with an
error of AMQ4353 in the install log.

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled and you do not complete the Prepare
WebSphere MQ Wizard directly after WebSphere MQ installs or if for any reason
your machine is rebooted between completing WebSphere MQ installation and
completing the Prepare WebSphere MQ Wizard, ensure the wizard is run with
Administrator privilege, otherwise the wizard might fail. You might also see Open
File - Security Warning dialog boxes that list International Business Machines
Limited as the publisher. Click Run to allow the wizard to continue

An example of the file MQParms.ini is supplied with WebSphere MQ. This file
contains default installation parameters.

There are two ways to create a parameter file for installation:
v Copy and edit the file MQParms.ini that is supplied in the root folder of the

WebSphere MQ Server CD, using an ASCII file editor.
v Create your own parameter file using an ASCII file editor.

About this task

To invoke installation using the MQParms command:
1. From a command line, change to the root folder of the WebSphere MQ Server

CD (that is, the location of the file MQParms.exe).
2. Enter the following command:

MQParms [parameter_file] [parameters]

where:

parameter_file
is the file that contains the required parameter values. If this file is not
in the same folder as MQParms.exe, specify the full path and file name.
If you do not specify a parameter file, the default is MQParms.ini. For
further details, see “MQParms parameter file” on page 43.

parameters
are one or more command line parameters, as listed in Table 4 on page
31.

Example

A typical example of an MQParms command is:
MQParms c:\MyParamsFile.ini /l*v c:\install.log
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If you specify a parameter both on the command line and in the parameter file, the
setting on the command line takes precedence.

If you specify a parameter file, you might want to run the encryption utility before
you use the MQParms command (see “Encrypting a parameter file” on page 47).

If you do not specify /i, /x, /a, or /j, MQParms defaults to standard installation
using the WebSphere MQ Windows Installer package, IBM WebSphere MQ.msi.
That is, it generates the following part of the command line:
/i "current_folder\MSI\IBM WebSphere MQ.msi"

If you do not specify a WIZPARMFILE parameter, MQParms defaults to the
current parameter file. That is, it generates the following part of the command:
WIZPARMFILE="current_folder\current_parameter_file"

MQParms parameter file:

A parameter file is an ASCII text file that contains sections (stanzas) with
parameters that can be used by the MQParms command. Typically, this is an
initialization file such as MQParms.ini.

The MQParms command takes parameters from the following stanzas in the file:

[MSI] Contains general properties related to how the MQParms command runs and
to the installation of WebSphere MQ.

The properties that you can set in this stanza are listed in Table 4 on page
31, Table 5 on page 33, Table 6 on page 34, and Table 10 on page 44.

[Services]
Contains properties related to WebSphere MQ account configuration, in
particular, the user account required for WebSphere MQ Services. If you
are installing WebSphere MQ on a network where the domain controller is
on a Windows 2003 server, you probably need details of a special domain
account. For further information, see “Configuring WebSphere MQ
accounts” on page 57 and “Configuring WebSphere MQ with the Prepare
WebSphere MQ wizard” on page 52.

The properties that you can set in this stanza are listed in Table 12 on page
45.

[SSLMigration]
Contains properties relating to the scheduling of SSL resource migration.

The properties that you can set in this stanza are listed in Table 13 on page
46.

MQParms ignores any other stanzas in the file.

The stanza parameters are in the form property=value, where property is always
interpreted as upper case, but value is case sensitive. If a value string includes a
blank, it must be enclosed in double quotation marks. Most other values can be
enclosed in double quotation marks. Some properties can take more than one
value, for example:
ADDLOCAL="Server,Client"

To clear a property, set its value to an empty string, for example:
REINSTALL=""
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The following tables show the properties that you can set. The default is shown in
bold.

For the [MSI] stanza, you can enter parameters in command line format (for
example, /q) and parameters in property=value format (for example,
ADDLOCAL="Server"). Refer to Table 6 on page 34, Table 4 on page 31, and Table 5 on
page 33 for the properties used to install WebSphere MQ. Table 10 shows
additional properties in the stanza that affect how the MQParms command runs, but
that do not affect the installation.

Table 10. Properties used by MQParms in the MSI stanza

Property Values Description

MQPLOG path|file_name MQParms generates a text log file with
the specified name and location.

MQPLANGUAGE
system|user|
transform_value|existing

The installation language.

system. Install using the language of
the default system locale (the default).

user. Install using the language of the
default locale of the user.

transform_value. Install using the
language specified by this value. See
Table 11.

existing. If MQ already exists on the
system, the same language will be used
by default, otherwise system is used.

MQPSMS 0|no 0 or no. MQParms does not wait for the
msiexec command to end (the default).

Any other value. MQParms waits for
the msiexec command to end.

MQPINUSE 0|1 If MQPINUSE is set to 1, MQParams
continues installing even if WebSphere
MQ files are in use. If this option is
used a reboot will be required to
complete the installation.

MQPNOREBOOT 0|1 If MQPNOREBOOT is set to 1, the
reboot that is required if installation
takes place while WebSphere MQ files
are still in use will be suppressed.

Table 11. Valid values for the MQPLANGUAGE property

Language Valid values

U.S. English English en_us 1033

German German de_de 1031

French French fr_fr 1036

Spanish Spanish es_es 1034

Italian Italian it_it 1040

Brazilian Portuguese Brazilian Portuguese pt_br 1046

Japanese Japanese ja_jp 1041

Korean Korean ko_kr 1042
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Table 11. Valid values for the MQPLANGUAGE property (continued)

Language Valid values

Simplified Chinese Simplified Chinese zh_cn 2052

Traditional Chinese Traditional Chinese zh_tw 1028

Czech Czech cs_cz 1029

Russian Russian ru_ru 1049

Hungarian Hungarian hu_hu 1038

Polish Polish pl_pl 1045

For the [Services] stanza, you can enter parameters in property=value format. You
might want to encrypt the values in this stanza. See “Encrypting a parameter file”
on page 47.

Table 12. Properties in the Services stanza

Property Values Description

USERTYPE local | domain |
onlydomain

The type of user account to use:

local Creates a local user account.

domain
Creates a local user account. If
this does not have the required
security authorities, it uses the
domain user account specified
by DOMAINNAME,
USERNAME, and PASSWORD.

onlydomain
Does not create a local user
account, but immediately uses
the domain user account
specified by DOMAINNAME,
USERNAME and PASSWORD.
If any of these three properties
are missing, a USERTYPE of
local is assumed.

The properties DOMAINNAME,
USERNAME, and PASSWORD are
required if USERTYPE is set to
onlydomain.

DOMAINNAME domain_name1 The domain for the domain user
account.

Required if USERTYPE is set to domain
or onlydomain.

USERNAME user_name1 The user name for the domain user
account.

Required if USERTYPE is set to domain
or onlydomain..

PASSWORD password1 The password for the domain user
account.

Required if USERTYPE is set to domain
or onlydomain.
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Table 12. Properties in the Services stanza (continued)

Property Values Description

1. Do not enclose this value in double quotation marks.

For the [SSLMigration] stanza, you can enter parameters in property=value format.

Table 13. Properties in the SSLMigration stanza

Property Values Description

SCHEDULE yes|no This property specifies whether SSL
migration is to be scheduled. If this
property is omitted or set to no, all
other properties in this stanza are
ignored and no error is raised.

QMGRS qmgr_name, qmgr_name,
...

A comma separated list of queue
managers for which certificate transfer
to GSKit key database files is
scheduled.

QMGRPASSWORD password|password,
password, ...

Passwords to use for the GSKit key
database files. This property is required
if QMGRS is present. If this contains
only one password that password will
be used for all the queue managers. If it
contains more than one password there
must be the same number of passwords
as there are queue managers specified
in QMGRS.

QMGREXPIRY interval|interval, interval,
...

Expiry intervals to set for the
passwords used. If nothing is specified,
the default value of 60 days is used. If
this contains only one value, that value
will be used for all queue managers. If
it contains more than one value, there
must be the same number of expiry
intervals as there are queue managers
specified in QMGRS..

CLIENTSTORES file_name, file_name, ... A comma separated list of the client
SSL certificate stores to schedule for
transfer to GSKit key database files.

CLIENTPASSWORD password|password,
password, ...

Passwords to use for GSKit key
database files. This property is
rerquired if CLIENTSTORES is present.
If this contains only one password, the
password will be used for all client
stores. If it contains more than one
password, there must be the same
number of passwords as files given in
CLIENTSTORES.
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Table 13. Properties in the SSLMigration stanza (continued)

Property Values Description

CLIENTEXPIRY interval|interval, interval,
...

Expiry intervals to set for the
passwords used. If nothing is specified,
the default value of 60 days is used. If
this contains only one value, that value
will be used for all queue managers. If
it contains more than one value, there
must be the same number of expiry
intervals as there are queue managers
specified in CLIENTSTORES.

IGNOREERRORS yes|no Whether to continue processing if an
error is detected when scheduling the
transfer of certificate stores to GSKit
key database files.

A typical example of a parameter file is:
[MSI]
MQPLANGUAGE=1033
MQPLOG=%temp%\MQParms.log
MQPSMS=no
ADDLOCAL=Server
/m miffile
REMOVE=""
/l*v c:\install.log

[Services]
USERTYPE=domain
DOMAINNAME=mqm*df349edfcab12
USERNAME=mqm*a087ed4b9e9c
PASSWORD=mqm*d7eba3463bd0a3

[SSLMigration]
SCHEDULE=yes
QMGRS="qmgr1,qmgr2"
QMGRPASSWORD="password1,password2"

Encrypting a parameter file:
Before you begin

Use the setmqipw utility to encrypt the DOMAINNAME, USERNAME, and
PASSWORD values in the [Services] stanza of a parameter file, if they are not
already encrypted. (These values might be encrypted if you have run the utility
before.) setmqipw will also encrypt the QMGRPASSWORD and
CLIENTPASSWORD values in the [SSLMigration] stanza of a parameter file.

This encryption means that, if you need a special domain account to configure
WebSphere MQ (see “Configuring WebSphere MQ accounts” on page 57), or you
need to keep key database passwords secret, details are kept secure. Otherwise,
these values, including the domain account password, flow across the network as
clear text. You do not have to use this utility, but it is useful if security in your
network is an issue.
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About this task

To run the script:
1. From a command line, change to the folder that contains your parameter file.
2. Enter the following command:

CD_drive:\setmqipw

Note: You can run the command from a different folder, by entering the
following command, where parameter_file is the full path and file name of the
parameter file:
CD_drive:\setmqipw parameter_file

Results

If you view the resulting parameter file, the encrypted values start with the string
mqm*. Do not use this prefix for any other values; passwords or names that begin
with this prefix are not supported.

The utility creates a log file, setmqipw.log, in the current directory. This file
contains messages related to the encryption process. When encryption is successful,
messages are similar to:
Encryption complete
Configuration file closed
Processing complete

What to do next

After you encrypt the parameter file, you can use it in the normal way with the
MQParms command (see “Using the MQParms command” on page 41).

Installing with Microsoft System Management Server
WebSphere MQ is supplied with two sample definition files to create an System
Management Server (SMS) Package (these can be found on the WebSphere MQ
server CD). These are:
v WebSphere MQ.pdf

You will need to update the CommandLine parameter supplied in the definition
files by stating the path to where you have the file IBM WebSphere MQ.msi. This
file is supplied on the WebSphere MQ server CD by going to MSI\IBM WebSphere
MQ.msi.

Please refer to the Microsoft System Management Server documentation for the
version of SMS you are using to get full information on how to create and run a
job.

Once the Package has been created, an SMS job can be configured to install
WebSphere MQ.

Note:

1. You must be logged onto the target machine with Administrator authority to
install WebSphere MQ.
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Modifying your installation

Modifying the installation using WebSphere MQ Installation
Launchpad

Before you begin

To modify an installation, some feature of WebSphere MQ Version 7.0 must already
be installed.

About this task

To remove or install WebSphere MQ features follow the instructions below. This is
the only method to remove or install WebSphere MQ features on Windows Vista
and Windows Server 2008:
1. Insert the WebSphere MQ for Windows Server CD into the CD-ROM drive.
2. If autorun is installed, the installation process starts.

Otherwise, double-click the Setup icon in the root folder of the CD to start the
installation process.
The WebSphere MQ Installation Launchpad window is displayed.

3. Click the WebSphere MQ Installation option.
4. Click Launch WebSphere MQ Installer. Wait until the WebSphere MQ Setup

window is displayed with a welcome message.
5. Click Next to continue. The Program Maintenance panel is displayed.
6. Select Modify, then click Next.

The Features panel is displayed (see Figure 3).

7. Click the + symbol to the left of a feature to show any dependent features
(subfeatures).

8. To change the installation of a feature:
a. Click the symbol to the left of the feature name to display a drop-down

menu.

Figure 3. Setup features panel
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b. Select the required option from:
v Install this feature
v Install this feature and all its subfeatures (if any)
v Do not install this feature (remove if already installed)

The symbol to the left of the feature name changes to show the current
installation option.

9. When your selections are complete, click Next. WebSphere MQ installation
begins.

Modifying the installation using Add/Remove Programs
Before you begin

To modify an installation, some feature of WebSphere MQ Version 7.0 must already
be installed.

About this task

This method for modifying the installation applies only to Windows 2003 and
Windows XP. You cannot use this method to modify an installation on Windows
Vista or Windows Server 2008. Instead you should use the method described in:
“Modifying the installation using WebSphere MQ Installation Launchpad” on page
49.

To remove or install WebSphere MQ features follow the instructions below:
1. From the Windows taskbar, click Start → Settings → Control Panel,
2. Click Add/Remove Programs.
3. Click IBM WebSphere MQ.
4. Click Change.

The WebSphere MQ Setup window with the Program Maintenance panel is
displayed.

5. Click Next.
6. Select Modify, then click Next.

The Features panel is displayed (see Figure 4 on page 51).
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7. Click the + symbol to the left of a feature to show any dependent features
(subfeatures).

8. To change the installation of a feature:
a. Click the symbol to the left of the feature name to display a drop-down

menu.
b. Select the required option from:
v Install this feature
v Install this feature and all its subfeatures (if any)
v Do not install this feature (remove if already installed)

The symbol to the left of the feature name changes to show the current
installation option.

9. When your selections are complete, click Next. WebSphere MQ installation
begins.

Silently modifying a WebSphere MQ server installation using
msiexec

To silently modify an installation using msiexec, follow the instructions on the
installation pages, but set the ADDLOCAL parameter to include the features you
want to add, and set the REMOVE parameter to the features you want to remove.

For example if you used ADDLOCAL=″JavaMsg″ and REMOVE=″″ it would
modify the installation to include the Java Messaging and Web Services feature.

The instructions for msiexec begin here: “Installing using msiexec” on page 28

Figure 4. Setup features panel
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Configuring a WebSphere MQ Server
After installing WebSphere MQ, it is necessary to configure it. The configuration
described in this topic is for an environment that uses TCP/IP. The configuration
procedure is the same for environments that use other communications protocols
(for example, SNA, SPX, or NetBIOS). However, not all of the functions and
facilities of WebSphere MQ for Windows are available in these environments. The
items that are not available are:
v WebSphere MQ Postcard
v WebSphere MQ Explorer

If you are setting up WebSphere MQ for use with the Microsoft Cluster Service
(MSCS), see WebSphere MQ System Administration Guide for more information.

Using WebSphere MQ Remotely
If you are connecting to a Windows machine using either Terminal Services or a
Remote Desktop Connection and you have problems creating, starting or deleting a
queue manager this might be because of the introduction of a new user right,
“Create global objects”.

The “Create global objects” user right limits the users authorized to create objects
in the global namespace. In order for an application to create a global object, it
must either be running in the global namespace, or the user under which the
application is running must have the “Create global objects” user right applied to
it.

When you connect remotely to a Windows machine using either Terminal Services
or Remote Desktop Connection, applications run in their own local namespace. If
you attempt to create or delete a queue manager using WebSphere MQ Explorer or
the crtmqm or dltmqm command, or to start a queue manager using the strmqm
command, it will result in an authorization failure. This will create a WebSphere
MQ FDC with Probe ID XY132002.

Starting a queue manager using the WebSphere MQ Explorer, or using the
amqmdain qmgr start command will work correctly because these commands do
not directly start the queue manager. Instead the commands send the request to
start the queue manager to a separate process running in the global namespace.

If you need to perform any of these operations on a queue manager when
connected remotely to a Windows machine, you must have the “Create global
objects” user right. For information on how to assign a user this right, see your
operating system documentation.

Administrators have the “Create global objects” user right by default, so if you are
an administrator you will be able to create and start queue managers when
connected remotely without altering your user rights.

Configuring WebSphere MQ with the Prepare WebSphere MQ
wizard

About this task

The Prepare WebSphere MQ wizard helps you to configure WebSphere MQ files
and a user account for your network, migrate any queue managers and data from
a previous installation, and migrate WebSphere MQ clients and queue managers
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that have been set up to use Secure Sockets Layer (SSL).You must run the wizard
to configure the WebSphere MQ Service before you can start any queue managers.

The Prepare WebSphere MQ wizard window will be displayed when WebSphere
MQ installation completes. Follow the instructions given by the wizard to
configure WebSphere MQ. At any time while the wizard is running you can click
the More Information button in the wizard to view online help about the task you
are doing.
1. When WebSphere MQ installation completes, the Prepare WebSphere MQ

Wizard window is displayed with a welcome message.
v For Windows Vista and Windows Server 2008 users with UAC enabled

only: if you do not complete the Prepare WebSphere MQ Wizard directly
after WebSphere MQ installs or if for any reason your machine is rebooted
between completing WebSphere MQ installation and completing the Prepare
WebSphere MQ Wizard, accept the Windows prompt when it appears to
allow the wizard to run as elevated.

To continue, click Next

2. If you have run the Prepare WebSphere MQ wizard before, this step is
skipped. If you have not run the Prepare WebSphere MQ wizard before, the
Prepare WebSphere MQ Wizard window displays a progress bar with the
following message:
Status: Setting up WebSphere MQ Configuration

Wait until the progress bar completes.
3. The Prepare WebSphere MQ Wizard window displays a progress bar with the

following message:
Status: Setting up the WebSphere MQ Service.

Wait until the progress bar completes.
4. WebSphere MQ will attempt to detect whether you need to configure

WebSphere MQ for use with Windows 2000 or later domain users. Depending
on the results of the detection, WebSphere MQ will do one of the following:
v If WebSphere MQ detects that you need to configure WebSphere MQ for

Windows 2000 or later domain users, the Prepare WebSphere MQ Wizard
window displays a message that starts:
WebSphere MQ does not have the authority to query information about
your user account

Optionally, to see online help about configuring the domain account, select
More Information. When you are finished, close the WebSphere MQ Help
Center window to return to the current window.
Click Next, and go to step 5.

v If you are not installing on a Windows 2000 or later domain server and
WebSphere MQ cannot detect whether you need to configure WebSphere
MQ for Windows 2000 or later domain users, the Prepare WebSphere MQ
Wizard window displays the following message:
Are any of the domain controllers in your network running
Windows 2000 or later domain server?

If you select Yes, click Next, then go to step 5.
If you select No, click Next, then go to step 8.
If you select Don’t know, you cannot continue. Either select one of the
other options, or click Cancel and contact your domain administrator.
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v If WebSphere MQ detects that you do not need to configure WebSphere MQ
for Windows 2000 or later domain users, go to step 7.

Note: At any time, you can click More Information to view online help about
configuring the domain account, or see “Configuring WebSphere MQ
accounts” on page 57. When you are finished, close the WebSphere MQ Help
Center window to return to the current window.

5. The Prepare WebSphere MQ Wizard window displays the following message:
Do you need to configure WebSphere MQ for users defined on Windows 2000
or later domain controllers?

If you select Yes, click Next, then go to step 6.
If you select No, click Next, then go to step 8.
If you select Don’t know, you cannot continue. Either select one of the other
options, or click Cancel and contact your domain administrator.

Note: At any time, you can click More Information to view online help about
configuring the domain account, or see “Configuring WebSphere MQ
accounts” on page 57. When you are finished, close the WebSphere MQ Help
Center window to return to the current window.

6. In the next window, enter the Domain and User ID of the domain user
account that you obtained from your domain administrator. Either enter the
Password for this account, or select the option This account does not have a
password. Click Next.

7. The Prepare WebSphere MQ Wizard window displays a progress bar with the
following message:
Status: Configuring WebSphere MQ with the special domain user account

Wait until the progress bar completes.
If there are any problems with the domain user account, a further window is
displayed. Follow the advice on this window before you continue with this
procedure.

8. If you do not have any queue managers or WebSphere MQ clients on this
computer that have been set up to use Secure Sockets Layer (SSL) connections,
this step is missed, go to step 15.
If you have queue managers or WebSphere MQ clients on this computer that
have been set up to use SSL connections, the Migration of SSL connections
window is displayed. The queue managers and clients with SSL connections
were identified when you used the Check WebSphere MQ Certificate Stores
wizard in the installation launchpad. Read the information then click Next.

Note: At any time, you can click More Information to view online help about
identifying if migration is required. When you are finished, close the
WebSphere MQ Help Center window to return to the current window.

9. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. A list of the certificate store files, which were validated earlier in
the install process, is displayed. Select the certificate stores you want to
schedule for migration and click Next. If you did not validate any certificate
stores, or if you have not selected any, click Next then go to step 13.

10. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. The next panel asks you about passwords and password expiry
intervals.
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v If want to use a single password and expiry interval for all key databases
files, select Use a single password and expiry interval for all key database
files, enter a password and expiry interval, then click Next.

v If you want to use different passwords and expiry intervals for each
database file, select Prompt for individual passwords and expiry intervals,
then click Next.

11. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. A progress dialog is displayed while the certificate store files
chosen in step 9 are scheduled for migration. If you selected “Prompt for
individual passwords and expiry intervals” in step 10, a panel requesting this
information will be displayed for each certificate store file you selected.
Complete the information in each of the panels displayed, then click Next.

12. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. A panel is displayed showing a summary of the store files that
have been scheduled for migration. Click Next to continue.

13. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. Now the wizard asks you to confirm that your Certificate
Revocation Lists (CRLs) and Authority Revocation Lists (ARLs) are in a
format supported by WebSphere MQ Version 7.0.
v If CRLs and ARLs are not used, select Not Used and click Next.
v If CRLs and ARLs are used, when you have them in a format supported by

WebSphere MQ Version 7.0 select Yes and click Next.

Note: At any time, you can click More Information to view online help about
converting the CRLs and ARLs into a supported format. When you are
finished, close the WebSphere MQ Help Center window to return to the
current window.

14. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. Next you must ensure that SSL connections that use the SSLPEER
channel parameter have any multiple Organizational Unit entries ordered
correctly.
v If the SSLPEER value is not used, or if the SSLPEER value is used but

multiple Organizational Unit entries are not used, select Not Used and click
Next.

v If the SSLPEER value is used with multiple Organizational Unit entries,
check the ordering of the SSLPEER fields and select Yes when they are
correctly ordered. Click Next.

Note: At any time, you can click More Information to view online help about
how to check SSLPEER fields. When you are finished, close the WebSphere
MQ Help Center window to return to the current window.

15. The Prepare WebSphere MQ Wizard window displays a progress bar with the
following message:
Status: Starting WebSphere MQ services

Wait until the progress bar completes.
16. If there are further tasks to complete, the Prepare WebSphere MQ Wizard

window displays the following message:
It is recommended that the following tasks are completed now

It displays one or more of the following options, which depend on whether a
default configuration or queue managers already exist from a previous
installation. If the previous installation is such that none of these tasks apply,
this window is not displayed. Go to step 17.
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v Setup the Default Configuration. This option is displayed only if there are
no queue managers and there is no Default Configuration already on the
system. This action launches the Default Configuration wizard (see “Using
the Default Configuration wizard” on page 60).
In this situation, to verify the installation by using the Postcard application
(described in “Using the Postcard application” on page 63), select this
option and use the Default Configuration wizard to create the default queue
manager for the Postcard application to use.

v Migrate the existing Default Configuration. This option is displayed if a
Default Configuration already exists from MQSeries V5.1. This action
launches the Default Configuration wizard (see “Using the Default
Configuration wizard” on page 60).

Note: If a Default Configuration already exists from a version of
WebSphere MQ later than V5.1 you can use this without any migration.

To launch a wizard to complete a task, select the required option. When all
required tasks are complete and you return to this window, click Next.
To continue without completing any of these tasks, click Next. You can
complete these tasks later:
v To set up the Default Configuration, or migrate an existing Default

Configuration, use any of these methods:
– Run the Prepare MQ Wizard again from the Start menu.
– Open the Welcome Pages and select the link to Default Configuration

(see “Using the WebSphere MQ Welcome pages” on page 61).
– Use the command amqmgse at a command prompt.

17. Next you need to select the options that you require. The Prepare WebSphere
MQ Wizard window displays the following message:
You have completed the Prepare WebSphere MQ Wizard

Select the options that you require, then click Finish. Select one or more from:
v Remove the shortcut to this wizard from the desktop

This option is available only if you have previously attempted installation,
but you cancelled the procedure from the Prepare WebSphere MQ wizard
and you created a desktop shortcut to this wizard. Select this option to
remove the shortcut. You do not need it now that you have completed the
Prepare WebSphere MQ wizard.

v Launch WebSphere MQ Explorer

The WebSphere MQ Explorer allows you to view and administer your
WebSphere MQ network.

v Launch Notepad to view the release notes

The release notes contain information on installing WebSphere MQ and also
late-breaking news that is available after the published documentation is
produced.

18. Follow the procedure described in “Final Installation tasks.”

Final Installation tasks
These are optional tasks that you can use to check the installation if you believe
there was a problem, or to verify installation messages after an unattended (silent)
installation for example.
1. Check for messages in the following files:
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a. MSInnnnn.LOG. This file is in your user Temp folder. It is an application log
that contains English messages written during installation. The log includes
a message indicating whether the installation was successful and complete.
This file is created if you have set up default logging. See “Creating a log
file when you install WebSphere MQ” on page 11.

b. If you used the launchpad to install WebSphere MQ, check
MQv7_Install_YYYY-MM-DDTHH-MM-SS.log in your user Temp folder,
where:

YYYY This is the year that you installed WebSphere MQ Version 7.0

MM This is the month that you installed WebSphere MQ, for example
this would be 09 if you installed in September

DD This is the day that you installed WebSphere MQ

HH-MM-SS
This is the time at which WebSphere MQ was installed

You can get to your user Temp directory by entering the following
command at the command prompt:
cd %TEMP%

c. amqmjpse.txt. This file is in the WebSphere MQ data files folder (default
c:\Program Files\IBM\WebSphere MQ). It is an application log that
contains English messages written during installation by the Prepare
WebSphere MQ wizard.

d. amqmsccw.txt. This file is in the WebSphere MQ data files folder (default
c:\Program Files\IBM\WebSphere MQ). It is an application log that
contains English messages written by the Check WebSphere MQ Certificate
Stores wizard.

2. Verify your installation, as described in “Using the Postcard application” on
page 63.

What to do next

Configuring WebSphere MQ accounts
WebSphere MQ checks that only authorized users can access queue managers or
queues. Whenever a user attempts such access, WebSphere MQ uses its own local
account to query information about the user. However, if a domain controller runs
on Windows 2000 or later, it can be set up so that local accounts cannot be used to
make these queries. In this situation, you must provide WebSphere MQ with a
special account to use. This is necessary when both of the following conditions
apply:
v Any domain controller on your network is running on Windows 2000 or later
v Local user accounts are not authorized to query the group membership of the

domain user accounts

If these conditions apply (or if you are not sure), give the information described in
the following section to your domain administrator, and ask for one of the special
accounts it describes. When you install the product, towards the end of the
installation procedure, in the Prepare WebSphere MQ wizard, you are asked to
enter details of this account (domain, user name, and password).

If these conditions apply and you install WebSphere MQ without a special account
(or without entering its details), many or all parts of WebSphere MQ will not work,
depending upon the particular user accounts involved. In particular, if you are
currently logged on with a domain user account, you cannot complete the Default
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Configuration, and the Postcard and API Exerciser applications will not work.
Also, WebSphere MQ connections to queue managers that run under domain
accounts on other computers might fail.

For information about the user rights required to take advantage of the Kerberos
authentication support, see WebSphere MQ Security.

For information about the user rights required to take advantage of the Active
Directory support, see WebSphere MQ Intercommunication.

For information about user accounts and access permissions, see WebSphere MQ
System Administration Guide.

Information for domain administrators

WebSphere MQ has a component, running as a Windows DCOM process, that
checks that any user account attempting to access WebSphere MQ is authorized. As
part of the check, the component must confirm that the account belongs to a group
that is a member of the local mqm group, such as DOMAIN\domain mqm. The
component itself by default runs under a local user account (MUSR_MQADMIN)
that WebSphere MQ creates at installation.

If any domain controller on your network is running on Windows 2000 or later,
that domain can be set up so that local user accounts do not have authority to
query the group membership of its domain user accounts. Such a setup prevents
WebSphere MQ from completing its check, and access fails. To resolve this, each
installation of WebSphere MQ on the network must be configured to run its service
under a domain user account that has the required authority. See “Creating and
setting up domain accounts for WebSphere MQ” for instructions on creating a
suitable domain account.

Note: If an installer carries on anyway and configures WebSphere MQ without a
special account, many or all parts of WebSphere MQ will not work, depending
upon the particular user accounts involved, as follows:
v An installer currently logged on with a domain user account will not be able to

complete the Default Configuration, and the Postcard and API Exerciser will not
work.

v WebSphere MQ connections to queue managers running under domain accounts
on other computers might fail.

v Typical errors include “AMQ8066: Local mqm group not found” and “AMQ8079:
Access was denied when attempting to retrieve group membership information
for user ’abc@xyz’”.

Creating and setting up domain accounts for WebSphere MQ
About this task

The following information is aimed at Domain Administrators. Repeat Steps 1 and
2 on page 59 below for each domain that has user names that will install
WebSphere MQ, to create an account for WebSphere MQ on each domain:
1. Create a domain group with a special name that is known to WebSphere MQ

and give members of this group the authority to query the group membership
of any account:
a. Log on to the domain controller as an account with domain administrator

authority.
b. From the Start menu, open Active Directory Users and Computers.
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c. Find the domain name in the navigation pane on the left, right-click it and
select New Group.

d. Type domain mqm, or the name of a group that is a member of the local
“mqm” group. (If you are using domain mqm, this exact string should be
used because it is understood and used by WebSphere MQ).

e. In Group scope select either Global or Universal.
f. In Group type select Security, and click OK.
g. View Active Directory Users and Computers in Advanced Features mode.
h. Find the domain name in the left panel, right-click the domain name, then

click Properties.
i. Click the Security tab.
j. Click Advanced.
k. Click Add, then type domain mqm (or a group that is a member of the local

“mqm” group) and click OK. A new dialog is displayed.
l. Click the Properties tab.
m. In the Apply onto box, change the view to User objects.
n. Select the allow check box for the following options:
v Read Group Membership

v Read Group MembershipSAM

o. Click OK to close each window.
2. Create one or more accounts, and add them to the group:

a. In Active Directory Users and Computers, create a user account with a
name of your choosing and add it to group “domain mqm” (or a group that
is a member of the local “mqm” group).

b. Repeat for all the accounts you want to create.
3. Repeat Steps 1 on page 58 and 2 for each domain that has user names that will

install WebSphere MQ, to create an account for WebSphere MQ on each
domain.

4. Use the accounts to configure each installation of WebSphere MQ:
a. Either use the same domain user account (as created in Step 1 on page 58)

for each installation of WebSphere MQ, or create a separate account for each
one, adding each to the “domain mqm” group (or a group that is a member
of the local “mqm” group).

b. When you have created the account or accounts, give one to each person
configuring an installation of WebSphere MQ. They should enter the
account details (domain name, user name and password) into the Prepare
WebSphere MQ Wizard. Give them the account that exists on the same
domain as their installing userid.

c. When you install WebSphere MQ on any computer on the domain, the
WebSphere MQ install program detects the existence of the “domain mqm”
group on the LAN, and automatically adds it to the local “mqm” group.
(The local “mqm” group is created during installation; all user accounts in it
have authority to manage WebSphere MQ). Thus all members of the
“domain mqm” group will have authority to manage WebSphere MQ on
this computer.

d. However, you do still need to provide a domain user account (as created in
Step 1 on page 58) for each installation, and configure WebSphere MQ to
use it when making its queries. The account details should be entered into
the Prepare WebSphere MQ Wizard that runs automatically at the end of
installation (the wizard can also be run at any time from the start menu).
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5. Set the password expiry periods:
v If you use just one account for all users of WebSphere MQ, consider making

the password of the account never expire, otherwise all instances of
WebSphere MQ will stop working at the same time when the password
expires.

v If you give each user of WebSphere MQ their own user account you will
have more user accounts to create and manage, but only one instance of
WebSphere MQ will stop working at a time when the password expires.

If you set the password to expire, warn the users that they will see a message
from WebSphere MQ each time it expires - the message warns that the
password has expired, and describes how to reset it.

What to do next

For more information, see the WebSphere MQ System Administration Guide.

Using the Default Configuration wizard
Before you begin

About this task

You can use the Default Configuration wizard to add the first configured queue
manager to this computer. This enables you to connect easily with other queue
managers in the same WebSphere MQ cluster. You can use the Default
Configuration wizard to create, view, or alter your default configuration. You can
also use this wizard to alter or display details of an existing queue manager that
was created by the default configuration.

For a new installation of WebSphere MQ, creating a default configuration enables
you to explore features of WebSphere MQ using the Postcard application, the API
Exerciser, and the WebSphere MQ Explorer.

The Postcard application provides a fast and simple way to verify that your
WebSphere MQ installation completed successfully. It uses the default queue
manager that is created during the default configuration. If you want to use the
Postcard application for verification, and you do not have any existing queue
managers, run the Default Configuration wizard first.

If you have migrated existing queue managers, or created any queue managers
since installing WebSphere MQ, you might not want to run the Default
Configuration wizard. This is because you cannot create the default configuration
if other queue managers already exist. If you have previously created any other
queue managers on this computer and you still want to set up a default
configuration, you must delete them before you run the Default Configuration
wizard.

Start the Default Configuration wizard by selecting the option Setup the Default
Configuration when the Prepare WebSphere MQ wizard completes during
WebSphere MQ installation. The Prepare WebSphere MQ wizard can be run at any
time after installation by selecting Start → Programs → IBM WebSphere MQ →
Prepare WebSphere MQ wizard.
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Using the WebSphere MQ Welcome pages
The WebSphere MQ Explorer Welcomes pages are a collection of resources that are
displayed over the Eclipse workbench the first time you launch WebSphere MQ
Explorer. They are intended to ease you into WebSphere MQ by pointing to
relevant applications, documentation, tutorials, and education.

You can use the items in the WebSphere MQ Welcome pages (see Figure 5) to
explore the facilities in WebSphere MQ. The Welcome pages are launched the first
time the WebSphere MQ Explorer is launched. The Welcome pages can be viewed
at any time from the WebSphere MQ Explorer by selecting Help → Welcome. There
are links to the following subjects from the Welcome pages:

Product Tour

Gives a brief overview of WebSphere MQ and helps you to learn more about the
concepts, functions, and interfaces that WebSphere MQ uses. The Product Tour can
also be run from the Installation Launchpad. A text-only version of the Product
Tour can also be opened from here.

Default Configuration

Allows you to add a configured queue manager to this computer for connecting
easily with other queue managers in the same WebSphere MQ cluster. You can also
use it to alter or display details of an existing queue manager created by the
default configuration. This feature is available only using TCP/IP.

Note: If you migrated existing queue managers, or if you have created any queue
managers after you installed WebSphere MQ, you might not want to use this
facility. This is because you can only set up a default configuration if there are no
queue managers already, and you might not want to delete your existing queue
managers.

Figure 5. Welcome pages
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Postcard

Allows you to try out WebSphere MQ messaging quickly and easily. You can send
a message either to your own machine or to another named user’s machine. It is
described in detail in “Using the Postcard application” on page 63.

API Exerciser

Allows you to experiment with the API calls that are provided in the WebSphere
MQ programming interface.

To use the API Exerciser:
1. Open the Get Started page of the Welcome pages.
2. Click Launch the MQ API Exerciser to launch the API Exerciser.
3. Use the tabs to select a page which has the API calls that you want to try.
4. Set the options that are relevant to that page.
5. Optionally, set the parameters or attributes that you want to use with the API

call.
6. Select the required API button.

The results of the call are displayed in the Status area of the window.

For further information about the API Exerciser, refer to the Information Center
online help. To display this help, select the Help button on the WebSphere MQ API
Exerciser window.

For further information about the API calls, refer to the WebSphere MQ
Application Programming Guide and the WebSphere MQ Application
Programming Guide manual. You can access these manuals from the Reference
section of the Information Center.

Tutorials

The tutorials show you how to perform basic tasks in WebSphere MQ. Using the
tutorials, you can perform the following tasks:
v Create a queue manager
v Create a queue
v Create a channel
v Put a message on a queue
v Get a message from a queue

Each tutorial builds upon WebSphere MQ objects that have been set up during
previous tutorials and so increase in complexity.

Using the Help Center

The Help Center gives you access to all task-oriented help, books on the IBM Web
site, and a link to the WebSphere MQ Information Center if you have installed it
from the WebSphere MQ Documentation CD.

The WebSphere MQ Help Center can be accessed from the WebSphere MQ
Explorer by selecting Help → Help Contents. See Figure 6 on page 63 for an
example of the help center.
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Verifying a server installation
Before you can use WebSphere MQ for Windows, you need to verify that the
product has correctly installed. You can verify a WebSphere MQ server installation
at different levels:
v A local (stand-alone) installation that has no communication links with other

WebSphere MQ installations.
If both queue managers are in the same cluster, see “Using the Postcard
application to verify a local installation” on page 64.
If both queue managers are not in the same cluster, see “Setting up the
installation” on page 68.

v A server-to-server installation that includes communication links to other
WebSphere MQ installations.
If both queue managers are in the same cluster, or channels are configured to
communicate between the two machines, see “Using the Postcard application to
verify a server-to-server installation” on page 66.
If both queue managers are not in the same cluster, and channels are not
configured to communicate between the two machines, see “Verifying a
server-to-server installation” on page 69.

For a client-to-server installation that includes communication links between a
server machine and a WebSphere MQ client, see “Verifying a WebSphere MQ
Client” on page 83.

Using the Postcard application
You can verify a local installation (which does not have any communication links
with other WebSphere MQ installations) by using the Postcard application that is
supplied with WebSphere MQ.

Figure 6. Help Center window
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You can also use the Postcard application to verify communication between your
server and the server of another named user that is running the Postcard
application, where that server is running WebSphere MQ and using TCP/IP.
Therefore, you can use the Postcard application to verify that you can
communicate with another server. To use the Postcard application for this type of
verification, either both servers must be in the same cluster or you must configure
channels to communicate between the two servers. You can use the Postcard
application with existing queue managers, if both queue managers belong to the
same cluster.

To ensure that both servers are part of the same cluster, you can do either of the
following:
v Run the Default Configuration wizard on both servers to create or alter the

default queue managers and link them to the default cluster (see “Using the
Default Configuration wizard” on page 60).

v Create your own queue managers on both servers, and either create a cluster
and ensure that the queue managers that you create on each server belong to the
same cluster, or configure channels to communicate between the two queue
managers.

To use the Postcard application to verify a local installation, see “Using the
Postcard application to verify a local installation.”

To use the Postcard application to verify a server-to-server installation, see “Using
the Postcard application to verify a server-to-server installation” on page 66.

Using the Postcard application to verify a local installation

You can use two instances of the Postcard application to verify that the local
installation is working.

Before you begin

To verify that the local installation is working, you can run two instances of the
Postcard application on the same server and send messages between the
applications. Successful sending and receiving of messages verifies that WebSphere
MQ is installed and working correctly on the server.

TCP/IP must be already installed on the server, and a queue manager that can be
used as a mailbox must be already set up. This queue manager can be either the
default queue manager, which is set up automatically during default configuration,
or another queue manager that you have set up yourself.

From WebSphere MQ Explorer:
1. Click Help → Welcome to open the welcome pages.
2. Click the Get Started icon to open the Get Started page.
3. Click Launch the Postcard Application to launch an instance of the Postcard

application.
4. The Postcard - Sign On window is displayed.

Type a nickname to use to send messages within the Postcard application (for
example, User1).
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v If the only queue manager on your server is the default queue manager that
you created by running the Default Configuration wizard, this queue
manager is used as your mailbox for postcards. Click OK to display your
first postcard, then go to step 6.

v If you do not have a default queue manager, or if you want to use a queue
manager you have created yourself, then go to step 5.

5. Optional: To select the queue manager to use as the mailbox, click the
Advanced checkbox, as shown in Figure 7. Then do one of the following:
v If you have created one or more of your own queue managers, but you

have not run the Default Configuration wizard, select the appropriate queue
manager from the list displayed.

v If you have run the Default Configuration wizard and you want to use the
default queue manager, but there is more than one queue manager on your
server, select Use Default Configuration as mailbox.

v If you have run the Default Configuration wizard, and also created one or
more of your own queue managers, and you do not want to use the default
queue manager, select Choose queue manager as mailbox, then select the
appropriate queue manager from the list displayed.

When your selection is complete, click OK.

6. From the Welcome pages, launch a second instance of the Postcard application
that you launched earlier in step 3.

7. The Postcard - Sign On panel is displayed again.
Type in a second nickname to use to send messages within the Postcard
application (for example, User2).

8. Repeat the selection of the queue manager that you want to use as the
mailbox (as described earlier in step 5).

Figure 7. Postcard - Sign On window with the Advanced options
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The queue manager that you select for this second postcard must either be in
the same cluster as the queue manager for the first postcard or you must have
configured channels to communicate between the two servers.
You now have two Postcard applications running, one with the nickname
User1 and one with the nickname User2.

9. In one of the Postcards (for example, User1), type some message text in the
Message: field and the nickname of the other Postcard (for example, User2) in
the To: field.

Note: Because the sender and receiver are on the same server, you do not
need to type anything in the On: field. If the receiver is on a different server
and is using the default queue manager as the mailbox, type the recipient’s
server in the On: field. An example server name is
machine2.server.company.com.

If the receiver is on a different server and is not using the default queue
manager as the mailbox, type the recipient’s queue manager in the On: field.

10. Click Send.
11. The Postcards sent and received area of the postcard shows details of the

message. In the sending postcard, the message is displayed as sent. In the
receiving postcard, the message is displayed as received.

12. From the receiving postcard, double-click on the message in the Postcards
sent and received area to view it. When this message arrives, this verifies that
WebSphere MQ is correctly installed.

Results

What to do next

Depending on your situation, you might want to do the following:
v Install WebSphere MQ on other servers. Follow the same installation procedure

that you used for the first server. Ensure that you use the Join Default Cluster
window in the Default Configuration application to add the other servers to
your first server’s cluster.

v Install the WebSphere MQ client on other servers. See Chapter 5, “Installing the
WebSphere MQ Client,” on page 75 or, if you are using the client CD see
WebSphere MQ Clients.

v Continue with further administration tasks. See the WebSphere MQ System
Administration Guide.

Using the Postcard application to verify a server-to-server
installation

You can use two instances of the Postcard application to verify that a
server-to-server installation is working.

Before you begin

To verify that a server-to-server installation is working on two servers, the sender
of the message and the receiver, you can use an instance of the Postcard
application on the sender server, and an instance of the Postcard application on the
receiver server, and send messages between the two Postcard applications.
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Successful sending and receiving of messages verifies that WebSphere MQ is
successfully installed, and that communication between the two servers is working
correctly. Before you start:
v Make sure that TCP/IP and WebSphere MQ are installed on both servers.
v Check that one of the following applies:

– Both servers are in the same cluster (this is the simplest method).
– You have configured channels to communicate between the two servers.

If the servers are not in the same cluster, and you do not have channels configured
to communicate between the two servers, follow the verification procedure given
in “Verifying a server-to-server installation” on page 69. This will verify the
communications between your server and another server without using the
Postcard application. During this verification you will configure channels to
communicate between the two servers. Therefore, you will be able to use the
Postcard application after running this verification if you wish to.

About this task

To verify that WebSphere MQ is successfully installed, and the communication
between two servers, the sender of the message and the receiver, is working
correctly you can use the Postcard application, as explained below.

From WebSphere MQ Explorer on the sender server:

1. Click Help → Welcome to open the welcome pages.
2. Click Get Started → Launch the Postcard Application to launch an instance of

the Postcard application.
3. The Postcard - Sign On window is displayed.

Type a nickname to use to send messages within the Postcard application (for
example, User1).
v If the only queue manager on your server is the default queue manager that

you created by running the Default Configuration wizard, this queue
manager is used as your mailbox for postcards. Click OK to display your
Postcard, then go to step 5.

v If you do not have a default queue manager, or if you want to use a queue
manager you have created yourself, then go to step 4.

4. Optional: To select the queue manager to use as the mailbox, click the
Advanced checkbox, then do one of the following:
v If you have created one or more of your own queue managers, but you have

not run the Default Configuration wizard, select the appropriate queue
manager from the list displayed.

v If you have run the Default Configuration wizard and you want to use the
default queue manager, but there is more than one queue manager on your
server, select Use Default Configuration as mailbox.

v If you have run the Default Configuration wizard and also created one or
more of your own queue managers, and you do not want to use the default
queue manager, select Choose queue manager as mailbox, then select the
appropriate queue manager from the list displayed.

When your selection is complete, click OK.
5. Type the following:
v Some message text in the Message: field.
v The nickname of the recipient in the To: field (for example, User2).
v The name of the queue manager that the recipient is using in the On: field.
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6. Click Send.

What to do next

From WebSphere MQ Explorer on the receiver server:

1. From Get Started on the Welcome pages, launch another instance of the
Postcard application.

2. Type the nickname of the recipient (for example, User2), then click OK to
display the Postcard window.

3. In the Postcards sent and received area of the postcard, details of the new
message are displayed. The message is displayed as received.
When this message arrives, this verifies that WebSphere MQ is correctly
installed and that your communication link between the two servers is working
correctly.

When all installation and verification is complete, you are ready to start using
WebSphere MQ (see the WebSphere MQ System Administration Guide).

Setting up the installation
If you do not want to use the Postcard application, you can verify a local
installation with a simple configuration of one queue manager and one queue. You
use sample applications to put a message onto the queue and to read the message
from the queue.

About this task

Use the following steps to install a queue manager and a queue:
1. Create a default queue manager called mercury.queue.manager. At the

command prompt in the window, enter the following command:
crtmqm -q mercury.queue.manager

The -q option specifies that this queue manager is the default queue manager.
Messages tell you that the queue manager is created, and that the default
WebSphere MQ objects are created.

2. Start the default queue manager. Enter the following command:
strmqm

A message tells you when the queue manager starts.
3. Enable MQSC commands by entering the following command:

runmqsc

The message Starting MQSC for queue manager mercury.queue.manager is
displayed when the MQSC session starts. MQSC has no command prompt.

4. Define a local queue called ORANGE.QUEUE. Enter the following command in the
MQSC commands window:
define qlocal(orange.queue)

Any text entered in MQSC in lowercase is converted automatically to
uppercase unless you enclose it in single quotation marks. This means that, if
you create a queue with the name orange.queue, you must remember to refer
to it in any commands outside MQSC as ORANGE.QUEUE.
The message WebSphere MQ queue created is displayed when the queue is
created.

5. Stop MQSC. Enter the following command in the MQSC commands window:
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end

The following messages are displayed, then the command prompt is displayed
again:
One MQSC commands read.
No commands have a syntax error.
All valid MQSC commands were processed.

Results

You have now defined the following objects:
v A default queue manager called mercury.queue.manager

v A queue called ORANGE.QUEUE

Testing the installation
About this task

To test the queue and queue manager, use the sample programs amqsput (to put a
message on the queue) and amqsget (to get the message from the queue):
1. To put a message on the queue, enter the following command:

amqsput ORANGE.QUEUE

The following message is displayed:
Sample amqsput0 start
target queue is ORANGE.QUEUE

2. Type some message text, then press Enter twice. The following message is
displayed:
Sample amqsput0 end

Your message is now on the queue and the command prompt is displayed
again.

3. To get the message from the queue, enter the following command:
amqsget ORANGE.QUEUE

The sample program starts, and your message is displayed. After a short pause,
the sample ends and the command prompt is displayed again.

Results

Verification of the local installation is now complete.

Verifying a server-to-server installation
If you do not want to use the Postcard application, you can use the following
procedures to verify a server-to-server installation.

These procedures are more complex than for a local installation, because the
communications link between the two machines must be checked. Before you can
do this, you must ensure that the communications protocol is installed and
configured on both systems. WebSphere MQ for Windows supports TCP, SNA,
NetBios and SPX. This example explains how to verify your installation if you use
TCP. If you use SNA, refer to WebSphere MQ Intercommunication.

To test the installation, you must set up two workstations, one as a sender and one
as a receiver.
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Setting up a sender workstation
Set up a sender workstation with a queue manager, a transmission queue, a remote
queue, and a sender channel.

About this task

Use the following steps to set up the sender machine:
1. Create a default queue manager called QMA. At a command prompt in a

window, enter the following command:
crtmqm -q QMA

The -q option specifies that this queue manager is the default queue
manager.Messages tell you that the queue manager is created, and that the
default WebSphere MQ objects are created.

2. Start the default queue manager. Enter the following command:
strmqm

A message tells you when the queue manager starts.
3. Enable MQSC commands. Enter the following command:

runmqsc

The message Starting WebSphere MQ Commands is displayed when MQSC has
started. MQSC has no command prompt.

4. In the MQSC command window, define a local queue called QMB to use as a
transmission queue. Enter the following command:
define qlocal(QMB) usage(xmitq)

The message WebSphere MQ queue created is displayed when the queue is
created.

5. In the MQSC command window, create a local definition of the remote queue.
Enter the following command:
define qremote(local.def.of.remote.queue) rname(apple.queue)
rqmname('QMB') xmitq(QMB)

The rname parameter specifies the name of the queue on the remote machine to
which the message will be sent. Therefore, the name that the rname parameter
specifies must be the name of the queue to which you want to send the
message (that is, APPLE.QUEUE on the receiver workstation).

6. On the receiver workstation, open a new command window and check which
ports are free. Enter the following command:
netstat -an

This shows you a list of running processes. Check the port number of each of
the processes to see if port 1414 is in use; you can find this by looking in the
Local Address column. The information is given in the form
ip_address:port_being _used.
If port 1414 is not in use, use 1414 as the port number in step 7, and as the port
for your listener later in the verification. If it is in use, select an alternative port
that is not in use; for example 1415 if this is not being used by another process.

7. On the sender workstation, in the MQSC command window, define a sender
channel. Enter the following command:
define channel(QMA.QMB) chltype(sdr) conname('con-name(port)')
xmitq(QMB) trptype(tcp) mcauser(MUSR_MQADMIN)
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Where:

con-name
is the TCP/IP address of the receiver workstation.

port is the port on which the listener will be running on the receiver
machine, the default value is 1414.

Note: Once you have set the mcauser attribute to MUSR_MQADMIN, you
MUST set the attribute back to its default value after you have verified the
installation to prevent any security vulnerabilities, as described in: “Post
verification tasks” on page 73

8. In the MQSC command window, stop MQSC. Enter the following command:
end

Results

You have now defined the following objects:
v A default queue manager called QMA

v A transmission queue called QMB

v A remote queue called LOCAL.DEF.OF.REMOTE.QUEUE

v A sender channel called QMA.QMB

Setting up a receiver workstation
About this task

Use the following steps to set up the receiver:
1. Create a default queue manager called QMB. At the command prompt, enter the

following command:
crtmqm -q QMB

Messages tell you that the queue manager is created, and that the default
WebSphere MQ objects are created.

2. Start the queue manager. Enter the following command:
strmqm

A message tells you when the queue manager starts.
3. Open a new command prompt window and enable MQSC commands. Enter

the following command:
runmqsc

The message Starting WebSphere MQ Commands is displayed when MQSC starts.
MQSC has no command prompt.

4. In the MQSC window, define a local queue called APPLE.QUEUE. Enter the
following command:
define qlocal(apple.queue)

The message WebSphere MQ queue created is displayed when the queue is
created.

5. In the MQSC window, create a receiver channel. Enter the following command:
define channel(QMA.QMB) chltype(rcvr) trptype(tcp)

6. Verification requires you to start the default WebSphere MQ listener on the port
number that you specified when setting up the sender workstation in step 7 on
page 70
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page 70. By default the listener will listen on port 1414. If you did not change
the default port whilst defining the sender channel on the sender workstation,
no action is required, proceed to the next step. If you specified a port other
than 1414 whilst setting up the sender workstation, alter the definition of the
SYSTEM.DEFAULT.LISTENER.TCP. For example, to use port 1415, enter the
following command in the MQSC window:

alter listener(system.default.listener.tcp) trptype(tcp)
port(port_number)

Where:

port_number
is the number of the port the listener should run on. This must be the
same as the number used when defining your sender channel.

7. In the MQSC window, start the default WebSphere MQ listener by entering the
following command:

start listener(system.default.listener.tcp)

8. In the MQSC window, verify the listener process has started by executing the
command:

display lsstatus(*)

9. In the MQSC window, stop MQSC. Enter the following command:
end

Results

You have now defined the following objects:
v A default queue manager called QMB

v A queue called APPLE.QUEUE

v A receiver channel called QMA.QMB

Starting the channels
About this task

Use the following steps to start the channels:
1. If the queue managers on the two workstations have stopped for any reason,

restart them now using the strmqm command.
2. On the sender workstation, enable MQSC commands. Enter the following:

runmqsc

3. Using the MQSC window, start the sender channel. Enter the following
command:
start channel(QMA.QMB)

The receiver channel on the receiver workstation is started automatically when
the sender channel starts.

4. Using the MQSC window, stop MQSC. Enter the following command:
end
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Testing communication between the workstations
About this task

Finally, use the following steps to test the communication between the sender and
receiver:
1. On the sender workstation, in a new command window, put a message on the

queue by entering the following command:
amqsput LOCAL.DEF.OF.REMOTE.QUEUE

This puts the message to the local definition of the remote queue, which in turn
specifies the name of the remote queue.

2. Type the text of the message, then press Enter twice.
3. On the receiver workstation, get the message from the queue by entering the

following command:
amqsget APPLE.QUEUE

The sample program starts, and your message is displayed. After a short pause,
the sample ends and the command prompt is displayed again.

Results

The verification of the server-to-server installation is now complete. You are ready
to start using WebSphere MQ (see the WebSphere MQ System Administration
Guide).

Post verification tasks
About this task

The verification process is now complete. To set the mcauser attribute back to its
default value:
1. Start MQSC commands if you have not already done so, by entering the

following command:
runmqsc

MQSC does not provide a prompt, but responds with the message:
Starting MQSC for queue manager queue.manager.1

2. In the MQSC window, set the mcauser attribute to its default value by entering
the following command:
alter channel(channel1) chltype(svrconn) mcauser(' ')

3. Optional: If you want to stop the queue manager on the server, type the
following command on the server machine:
endmqm queue.manager.1

4. Optional: If you want to delete the queue manager on the server, type:
dltmqm queue.manager.1

What to do next

Now that verification is complete, see the WebSphere MQ System Administration
Guide.
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Chapter 5. Installing the WebSphere MQ Client

This chapter describes how to install the WebSphere MQ Client using the
WebSphere MQ for Windows server CD. If you wish to install the WebSphere MQ
server, or for more information about WebSphere MQ clients and servers, see
Chapter 4, “Installing the WebSphere MQ Server,” on page 9.

You can install WebSphere MQ client using either the server or the client CD
provided with the product. The table below shows which CD to use for your
required installation

Table 14. Installation CD guide

Installation Feature required Install from Server CD Install from Client CD

Server Only X

Client Only On Windows Either CD may be used

Server and Client X

Client Extended Transaction
Support

X

Client File Transfer
Application

X (includes FTA GUI) X

Note: If you want to install the WebSphere MQ Client on a machine that does not
run a WebSphere MQ Server you can also install the WebSphere MQ Client using
the WebSphere MQ Client CD. The installation methods you use with this CD
differ slightly. To install using the Client CD see installation instructions in the
WebSphere MQ Clients book.

User Account Control (UAC) on Windows Vista and Windows Server
2008

Windows Vista and Windows Server 2008 introduce a User Account Control (UAC)
feature, which restricts the actions users can perform on certain operating system
facilities, even if they are members of the Administrators group.

UAC is enabled by default on Windows Vista and Windows Server 2008. This
means installing WebSphere MQ on Windows Vista or Windows Server 2008
differs from installing WebSphere MQ on previous versions of Windows. At certain
points during installation, migration, and uninstallation, you must manually accept
the Windows UAC prompt to allow processes to run with elevated authority.
During silent installation and uninstallation, you must invoke the process from an
elevated command prompt. The points when you have to accept the Windows
prompt for UAC or invoke processes from an elevated command prompt have
been flagged in the specific topics affected.

Preparing for client installation
Client installation considerations

For information about things to consider before installing a client, see:
v Chapter 6, “Installing WebSphere MQ documentation,” on page 89
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v “General considerations” on page 10
v “Naming considerations” on page 10
v “Security considerations” on page 10
v “Creating a log file when you install WebSphere MQ” on page 11
v “Default logging” on page 11

Client hardware and software requirements

For client hardware and software requirements see:
v “Client hardware”
v “Prerequisite client software”
v “Optional client software” on page 78

Client hardware
Hardware required to run WebSphere MQ for Windows in the client environment.

This section outlines the hardware requirements for a WebSphere MQ for Windows
client only. For details of the WebSphere MQ for Windows server environment, see
“Server hardware for WebSphere MQ for Windows” on page 12.

The client can run on any x86 or x86-64 technology-compatible PC hardware,
capable of running the required level of a compatible operating system. There must
be enough random access memory (RAM) and disk storage for the programming
prerequisites, the WebSphere MQ client, the access methods, and the application
programs.

Hardware requirements of WebSphere MQ client
v Any x86 or x86-64 technology-compatible PC hardware, capable of running the

required level of a compatible operating system .
v Any communications hardware supporting SNA LU 6.2, TCP/IP, NetBIOS, or

SPX is required for communication with other machines.
v The following disk space (for a typical installation):

– 570 megabytes (MB) for product code and data (not including the Information
Center)

– 20 MB minimum working space
– 30 MB of temporary space for the installation process

Hardware requirements of WebSphere MQ Explorer

If you want to use the WebSphere MQ Explorer, you will need a minimum of:
v 512 MB RAM
v 1 GHz processor
v 300 MB for Eclipse platform code and data
v A suitable monitor for the operating system with a screen size of at least

1024x768

Prerequisite client software

This information applies to the client environment only. The software requirements
for the WebSphere MQ for Windows server environment are in “Prerequisite server
software” on page 12.
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For the most-up-to date information regarding prerequisite software, refer to the
readme file.

The following are the prerequisites for running WebSphere MQ for Windows;
minimum supported levels are shown. Later compatible levels, if any, are
supported, unless otherwise stated.

Operating systems
Operating systems for WebSphere MQ for Windows in the client environment.

WebSphere MQ client requires one of the following:
v Microsoft Windows Server 2003. This can be one of the following products:

– Microsoft Windows Server 2003 Standard Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Enterprise Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Standard x64 Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 Enterprise x64 Edition (Service Pack 1 or

later)
– Microsoft Windows Server 2003 R2 Standard Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 R2 Enterprise Edition (Service Pack 1 or later)
– Microsoft Windows Server 2003 R2 Standard x64 Edition (Service Pack 1 or

later)
– Microsoft Windows Server 2003 R2 Enterprise x64 Edition (Service Pack 1 or

later)
v Microsoft Windows XP Professional. This can be either of the following

products:
– Microsoft Windows XP Professional (Service Pack 2 or later)
– Microsoft Windows XP Professional x64 Edition

v Microsoft Windows Vista. This can be one of the following products:
– Microsoft Windows Vista Business Edition
– Microsoft Windows Vista Enterprise Edition
– Microsoft Windows Vista Ultimate Edition
– Microsoft Windows Vista Business x64 Edition
– Microsoft Windows Vista Enterprise x64 Edition
– Microsoft Windows Vista Ultimate x64 Edition

v Microsoft Windows Server 2008. This can be one of the following products:
– Microsoft Windows Server 2008 Standard Edition
– Microsoft Windows Server 2008 Enterprise Edition
– Microsoft Windows Server 2008 Datacenter Edition
– Microsoft Windows Server HPC 2008
– Microsoft Windows Server Web 2008
– Microsoft Windows Server Storage 2008
– Microsoft Windows Server 2008 Standard x64 Edition
– Microsoft Windows Server 2008 Enterprise x64 Edition
– Microsoft Windows Server 2008 Datacenter x64 Edition
– Microsoft Windows Server Web 2008 x64
– Microsoft Windows Server Storage 2008 x64
– Microsoft Windows Small Business Server 2008 x64 for small businesses
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– Microsoft Windows Essential Business Server 2008 x64 for medium-sized
businesses

– Microsoft Windows Server 2008 for Itanium-based Systems

Connectivity
Supported software products to enable connectivity for Websphere MQ for
Windows

You require one of the following products:
v for SNA connectivity:

– IBM Communications Server for Windows, Version 6.1.2
– IBM Personal Communications for Windows Version 5.9, part of IBM Host

Access Client Package (HACP) V4.0
– Attachmate myEXTRA! Presentation Services, Version 7.11
– Attachmate EXTRA! X-treme V9
– Microsoft Host Integration Server 2006

v TCP/IP, NetBIOS, and SPX. These are part of the base operating system (SPX is
part of Windows XP and Windows 2003 only).

v WebSphere MQ client applications are supported on the Citrix Presentation
Server V4.5

Prerequisites for Windows XP and Windows Server 2003
Additional software required to run WebSphere MQ for Windows in the client
environment on Windows XP or Windows Server 2003.

Additional prerequisites for Windows XP and Windows Server 2003 are:
v For running .NET services, Microsoft Internet Information Services

Optional client software

The following are options, not prerequisites.
v Microsoft Windows Terminal Server feature

Compilers for WebSphere MQ applications (clients)
A list of supported compilers for WebSphere MQ for Windows

The following software compilers are supported:
v C and C++:

– Microsoft Visual Studio C++ 2005 SP1
– Microsoft Visual Studio C++ .NET 2003

Note: If you compile your application using Microsoft Visual Studio on one
system, and then copy the application to another system that does not have
Microsoft Visual Studio installed, you must install Microsoft Visual Studio
redistributable package (vcredist) on the target system.

v .NET
– Microsoft Visual C++ .NET 2003
– Microsoft Visual C++ .NET 2005
– Microsoft Visual C# .NET 2003
– Microsoft Visual C# .NET 2005
– Microsoft Visual Basic .NET 2003
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– Microsoft Visual Basic .NET 2005
v COBOL:

– IBM VisualAge COBOL Enterprise V3.0.1
– Micro Focus Net Express Version 4.0
– Micro Focus Net Express Version 5.0

v Visual Basic:
– Microsoft Visual Basic, Version 6.0

v JDK:
– 32-bit

- IBM Developer Kit for Windows, Java 2 Technology Edition V1.4.2.
- IBM Developer Kit for Windows, Java 2 Technology Edition V5.0 (SR1 or

above)
- IBM Developer Kit for Windows, Java 2 Technology Edition
- Java 2 Platform, Standard Edition V1.4.2 from Sun Microsystems, Inc.
- Java 2 Platform, Standard Edition V5.0 (SR1 or above) from Sun

Microsystems, Inc.
- Java 2 Platform, Standard Edition V6.0 from Sun Microsystems, Inc.

– 64-bit
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 1.4.2
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 5.0
- IBM 64-bit SDK for Windows AMD64/EM64T architecture, Java 2

Technology Edition, Version 6.0
- Sun Java 2 Platform Standard Edition, Version 5.0

For latest details, see the WebSphere MQ product family Web site at:

http://www.ibm.com/software/integration/mqfamily

WebSphere MQ client features

The following three features for the WebSphere MQ for Windows client
environment can be installed from the WebSphere MQ Server CD or the
WebSphere MQ Client CD:

Windows client
The WebSphere MQ client is a small subset of WebSphere MQ, without a
queue manager, that uses the queue manager and queues on other (server)
computers. It can be used only when the computer it is on is connected to
another computer that is running a full server version of WebSphere MQ.
The client and server can be on the same computer if required.

Java Messaging and Web Services
The files needed for messaging using Java (includes Java Message Service
support) and WebSphere MQ Web Services.

Development Toolkit
This feature includes sample source files, and the bindings (files .H, .LIB,
.DLL, and so on), that you need to develop applications to run on
WebSphere MQ. Bindings and samples are provided for the following
languages: C, C++, Visual Basic, ActiveX, Cobol, and .NET (including C#).
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Java and Java Message Service support is included and samples are
provided for MTS (COM+), and MQSC.

The following three features for the WebSphere MQ for Windows client
environment can be installed from the WebSphere MQ Server CD only:

Client File Transfer
The Client File Transfer Application allows you to send and receive
ordinary files in the form of WebSphere MQ messages. You can use the
Client File Transfer Application to send and receive any type of file in any
format, for example: ASCII Linux format (with line feed characters), ASCII
file Windows format (with carriage return/line feed characters), binary (for
example, image files, wordprocessor files, spreadsheet files, or zip files),
also reports, letters, memos and charts. The Client File Transfer Application
only has a command line interface.

Client Extended Transaction Support
A WebSphere MQ extended transactional client is a WebSphere MQ client
with some additional function. This function allows a client application,
within the same unit of work:
v To put messages to, and get messages from, queues that are owned by

the queue manager to which it is connected.
v To update the resources of a resource manager other than a WebSphere

MQ queue manager.

Java Extended Transaction Support
Extended transaction support for Java Message Service.

For information on WebSphere MQ feature prerequisites, see “Prerequisites for
WebSphere MQ for Windows features” on page 20.

Methods of Installing the WebSphere MQ client
There are two different versions of the WebSphere MQ for Windows client
installation code, one on the WebSphere MQ Server CD, and one on the
WebSphere MQ Client CD. Both versions install the same files.

You can use the WebSphere MQ Server CD to install the WebSphere MQ client on
any client machine.

You can use the WebSphere MQ Client CD to install the WebSphere MQ client on
any client machine that does not have the WebSphere MQ server installed.

You might use the WebSphere MQ Client CD to install the WebSphere MQ client,
then subsequently decide to use that machine for the WebSphere MQ server. In this
situation, use the WebSphere MQ Server CD to install the WebSphere MQ server
and to reinstall the WebSphere MQ client.

To install the WebSphere MQ client, the following installation methods are
available:
v All methods that use the WebSphere MQ Server CD. See “WebSphere MQ Server

installation methods” on page 22
For the interactive installation, select the Custom installation type (“Launchpad
instructions” on page 23), and select the Windows client feature. No other
interactive method will install the client.

v Methods that use the WebSphere MQ Client CD:
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– See the WebSphere MQ Clients book.

During the installation of the runtime package on the Windows platform, a new
environment variable called MQ_FILE_PATH is configured.

This contains the same data as the following key in the Windows Registry:
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\MQSeries\CurrentVersion\FilePath

A new sample WebSphere MQ client configuration file is created in the var/mqm
directory, by the C client package, during installation, but only if this file does not
already exist. This file contains the ClientExitPath stanza. An example mqclient.ini
file is shown in WebSphere MQ client configuration file the WebSphere MQ System
Administration Guide.

Note that if you are using a common configuration file for multiple clients, either
in the WebSphere MQ installation directory or in another location using the
MQCLNTCF environment variable, you should grant read access to all user
identifiers under which the WebSphere MQ client applications run. If, for any
reason, the file cannot be read, the failure is traced and the search logic continues
as if the file had not existed.

Configuring a WebSphere MQ Client using the Prepare WebSphere MQ
wizard

About this task

The Prepare WebSphere MQ wizard helps you to migrate any Secure Socket Layer
connections from a previous installation.

The Prepare WebSphere MQ wizard window will be displayed when WebSphere
MQ installation completes. Follow the instructions given by the wizard to
configure WebSphere MQ. At any time while the wizard is running you can click
the More Information button in the wizard to view online help about the task you
are doing.
1. When WebSphere MQ installation completes, the Prepare WebSphere MQ

Wizard window is displayed with a welcome message.
v For Windows Vista and Windows Server 2008 users with UAC enabled

only: if you do not complete the Prepare WebSphere MQ Wizard directly
after WebSphere MQ installs or if for any reason your machine is rebooted
between completing WebSphere MQ installation and completing the Prepare
WebSphere MQ Wizard, accept the Windows prompt when it appears to
allow the wizard to run as elevated.

To continue, click Next

2. If you do not have any WebSphere MQ clients on this computer that have been
set up to use Secure Sockets Layer (SSL) connections, this step is missed, go to
step 9 on page 82.
If you have WebSphere MQ clients on this computer that have been set up to
use SSL connections, the Migration of SSL connections window is displayed.
The clients with SSL connections were identified when you used the Check
WebSphere MQ Certificate Stores wizard in the installation launchpad. Read
the information then click Next.
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Note: At any time, you can click More Information to view online help about
identifying if migration is required. When you are finished, close the
WebSphere MQ Help Center window to return to the current window.

3. A list of the certificate store files, which were validated earlier in the install
process, is displayed. Select the certificate stores you want to schedule for
migration and click Next. If you did not validate any certificate stores, or if you
have not selected any, click Next then go to step 7.

4. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. The next panel asks you about passwords and password expiry
intervals.
v If want to use a single password and expiry interval for all key databases

files, select Use a single password and expiry interval for all key database
files, enter a password and expiry interval, then click Next.

v If you want to use different passwords and expiry intervals for each database
file, select Prompt for individual passwords and expiry intervals, then click
Next.

5. A progress dialog is displayed while the certificate store files chosen in step 3
are scheduled for migration. If you selected “Prompt for individual passwords
and expiry intervals” in step 4, a panel requesting this information will be
displayed for each certificate store file you selected. Complete the information
in each of the panels displayed, then click Next.

6. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. A panel is displayed showing a summary of the store files that
have been scheduled for migration. Click Next to continue.

7. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. Now the wizard asks you to confirm that your Certificate
Revocation Lists (CRLs) and Authority Revocation Lists (ARLs) are in a format
supported by WebSphere MQ Version 7.0.
v If CRLs and ARLs are not used, select Not Used and click Next.
v If CRLs and ARLs are used, when you have them in a format supported by

WebSphere MQ Version 7.0 select Yes and click Next.

Note: At any time, you can click More Information to view online help about
converting the CRLs and ARLs into a supported format. When you are
finished, close the WebSphere MQ Help Center window to return to the current
window.

8. This step is applicable only if you are migrating from WebSphere MQ
Version 5.3. Next you must ensure that SSL connections that use the SSLPEER
channel parameter have any multiple Organizational Unit entries ordered
correctly.
v If the SSLPEER value is not used, or if the SSLPEER value is used but

multiple Organizational Unit entries are not used, select Not Used and click
Next.

v If the SSLPEER value is used with multiple Organizational Unit entries,
check the ordering of the SSLPEER fields and select Yes when they are
correctly ordered. Click Next.

Note: At any time, you can click More Information to view online help about
how to check SSLPEER fields. When you are finished, close the WebSphere MQ
Help Center window to return to the current window.

9. The Prepare WebSphere MQ Wizard window displays the following message:
You have completed the Prepare WebSphere MQ Wizard
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Select Launch Notepad to view the release notes to view the release notes. The
release notes contain information on installing WebSphere MQ and also
late-breaking news that is available after the published documentation is
produced.
Click Finish.

Verifying a WebSphere MQ Client
About this task

You can verify your WebSphere MQ client and server installation using the
supplied sample put and get programs. These verify that your installation has been
completed successfully and that the client and server can communicate.

This section explains how to use the supplied sample put and get programs to
verify that a WebSphere MQ client has been installed correctly, by guiding you
though the following tasks:
1. “Setting up the WebSphere MQ server”
2. “Setting up the WebSphere MQ client” on page 85
3. “Putting a message on the queue” on page 86
4. “Getting a message from the queue” on page 86
5. “Post verification tasks” on page 73

These instructions assume that the WebSphere MQ Server feature is installed on a
server machine, and that the WebSphere MQ client feature in installed on a client
machine.

The transmission protocol used in the example is TCP/IP. It is assumed that you
have TCP/IP configured on the server and the WebSphere MQ client machines,
and that it is initialized on both the machines.

If you are not using TCP/IP, refer to the information about configuring
communication links in WebSphere MQ Clients.

Compiled sample amqsputc and amqsgetc are included in the WebSphere MQ
client directories that you installed.

The following sections provide step-by-step instructions for creating a queue
manager called queue.manager.1, a local queue called QUEUE1, and a
server-connection channel called CHANNEL1 on the server. They show how to
create the client-sever channel on the WebSphere MQ client workstation, and how
to use the sample programs to put a message onto a queue, and then get the
message from the queue.

Note: WebSphere MQ object definitions are case-sensitive. You must type the
examples exactly as shown.

Setting up the WebSphere MQ server
Before you begin

Before you can verify the client installation, you need to:
1. Create a default queue manager (called queue.manager.1) by entering the

following command at the command prompt:
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crtmqm -q queue.manager.1

The -q option specifies that this queue manager is the default queue manager.
2. Start the queue manager by entering the following command:

strmqm

3. Start MQSC commands by entering the following command:
runmqsc

MQSC does not provide a prompt, but responds with the message:
Starting MQSC for queue manager queue.manager.1

4. In the MQSC window, create a local queue called QUEUE1 by entering the
following command:
define qlocal(QUEUE1)

5. In the MQSC window, create a server-connection channel by entering the
following command:
define channel(channel1) chltype(svrconn) trptype(tcp) mcauser('MUSR_MQADMIN')

Note: Once you have set the mcauser attribute to MUSR_MQADMIN, you
MUST set the attribute back to its default value after you have verified the
installation to prevent any security vulnerabilities, as described in: “Post
verification tasks” on page 73

6. Verification requires you to start the default WebSphere MQ listener on the port
number that you specify when setting up the client-connection channel.
By default the listener will listen on port 1414. If you are not going to change
the default port when setting up the client workstation, no action is required,
proceed to the next step. If you are going to use a different port when setting
up the client workstation, alter the definition of the system.default.listener. For
example, to use port 2001, enter the command in the MQSC window:
alter listener(system.default.listener.tcp) trptype(tcp) port(2001)

Note: To check which ports are free enter the following command:
netstat -an

This will show you a list of running processes. Check the port number of each
of the processes to see if the port you plan to use is already in use. The port
number is in the Local Address column. The information is given in the form
computer_name:port_being _used

7. In the MQSC window, start the default WebSphere MQ listener by entering the
following command:
start listener(system.default.listener.tcp)

8. In the MQSC window, verify the listener process has started by executing the
command:
display lsstatus(*)

9. Stop MQSC by typing in the MQSC window:
end

and then pressing Enter.

Results

The following objects are now defined:
v A default queue manager called queue.manager.1
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v A local queue called QUEUE1

v A server-connection channel called CHANNEL1

Setting up the WebSphere MQ client
About this task

When a WebSphere MQ application is run on the WebSphere MQ client, the
binding information that it requires to connect to a specific queue manager is
defined in a client-connection channel. This information is the name of the MQI
channel, the communication type, and the address of the server to be used. You
provide this by defining a client-connection channel. The name used must be the
same as the name used for the server-connection channel defined on the server.

A client-connection channel can be defined in one of the following three ways:
v Define the environment MQSERVER variable on the client. See “Defining a

client-connection channel using MQSERVER.”
v Give the client access to the generated client channel definition table (that is, the

amqclchl.tab file). See the chapter about running applications on WebSphere MQ
clients in WebSphere MQ Clients.

v If Active Directory support is enabled, the client discovers the client-connection
information dynamically from the Active Directory. See the WebSphere MQ
Intercommunications book.

Example

In this example, the MQSERVER environment variable is used to define the
client-connection channel. This is the simplest method.

Before starting, confirm that your WebSphere MQ client and server TCP/IP
sessions are initialized. To do this, type the following command:
ping server_address

server_address is the TCP/IP hostname, or the network address (in the format
n.n.n.n), of the server.

If the ping command fails, check that your TCP/IP software is correctly configured
and has been started.

Defining a client-connection channel using MQSERVER
Before you begin

This section applies only if you are not using Active Directory Services support. If
you are using Active Directory Services support, you can omit the step in this
section.

About this task

Create a client-connection channel by setting the MQSERVER environment
variable.

Use the following command:
SET MQSERVER=CHANNEL1/TCP/server_address(port)

where:
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server_address
is the TCP/IP hostname of the server.

(port) is optional, and is the TCP/IP port number on which the server is
listening. This is the port number specified in step 6 on page 84 of “Setting
up the WebSphere MQ server” on page 83.

If you do not give a port number, WebSphere MQ uses the one specified in
the queue manager configuration information. If no value is specified in
the queue manager configuration information, WebSphere MQ uses the
port number identified in the TCP/IP services file for the service name
MQSeries. If this entry in the services file does not exist, a default value of
1414 is used.

It is important that the client and the server listener program both use the
same port number.

Putting a message on the queue
1. Enter the following command on the client machine:

amqsputc QUEUE1 queue.manager.1

The following message is displayed:
Sample AMQSPUT0 start
target queue is QUEUE1

2. Type some message text, then press Enter twice. The following message is
displayed:
Sample AMQSPUT0 end

Results

The message is now on the queue on the server queue manager.

Getting a message from the queue
About this task

On the WebSphere MQ client workstation, get a message from the queue using the
amqsgetc sample program:

Enter the following command:
amqsgetc QUEUE1 queue.manager.1

Results

The sample program starts, and your message is displayed. After a short pause
(Approximately 30 seconds), the sample ends and the command prompt is
displayed again. Alternatively you can press Ctrl-C to end the sample program.

Post verification tasks
About this task

The verification process is now complete. To set the mcauser attribute back to its
default value:
1. Start MQSC commands if you have not already done so, by entering the

following command:
runmqsc
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MQSC does not provide a prompt, but responds with the message:
Starting MQSC for queue manager queue.manager.1

2. In the MQSC window, set the mcauser attribute to its default value by entering
the following command:
alter channel(channel1) chltype(svrconn) mcauser(' ')

3. Optional: If you want to stop the queue manager on the server, type the
following command on the server machine:
endmqm queue.manager.1

4. Optional: If you want to delete the queue manager on the server, type:
dltmqm queue.manager.1

What to do next

Now that verification is complete, see the WebSphere MQ System Administration
Guide.
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Chapter 6. Installing WebSphere MQ documentation

Install the Infocenter WebSphere MQ documentation on your computer, read the
documentation directly from the installation image, or prepare to install the
documentation on other machines silently.

About this task

The WebSphere MQ documentation is supplied as a separate CD package
alongside the product. You can either view the documents directly from CD, or
you can install them on your computer (either before or after installing the
WebSphere MQ product).

To install the documentation, see “WebSphere MQ Information Center” on page
106.

What to do next

For prerequisites, or if you have any problems, see the readme file in the root
folder on the CD.

Unattended (Silent) installation of WebSphere MQ documentation
About this task

The WebSphere MQ documentation can be installed silently using InstallShield.
First, run the installation manually from a command window opened in the
installation directory, automatically saving the installation options you choose in a
file. Next, use the file to run InstallShield silently on other machines to create
identical installations.

Note: You cannot select the language to install silently: all languages are installed.
1. Save your installation options using the command shown in Figure 8.
2. Replay the installation silently on other machines using the command shown in

Figure 9.

Example

win32.exe -options-record drive-path\response-file.ini

Figure 8. Saving installation options

win32.exe -options drive-path\response-file.ini -silent

Figure 9. Replay installation silently
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Chapter 7. Applying maintenance

This topic explains how to maintain your installation of WebSphere MQ Version
7.0. You can download maintenance packages from:

http://www.ibm.com/software/integration/mqfamily/support/summary/

Attention
v There should be no WebSphere MQ applications running when you install

maintenance on WebSphere MQ.
v There should be no applications accessing remote WebSphere MQ machines

running when you install maintenance on WebSphere MQ.
v Stop all WebSphere MQ applications on the machine and the applications

accessing remote machines
v There should be no queue managers running when you install maintenance on

WebSphere MQ. End each queue manager that is running by issuing the
command:

endmqm -i QMgrName

and check that the queue manager has stopped running before you try to install
the maintenance package.

v There should be no channel listeners running when you install maintenance on
WebSphere MQ. To end all running listener processes for a queue manager:
1. Check that the queue manager is stopped.
2. End all listener processes by issuing the command:

endmqlsr -m QMgrName

v You must stop the WebSphere MQ service. To do this, right-click the WebSphere
MQ icon in the taskbar, then click Stop WebSphere MQ.

Querying the service level

After an update to the initial installation, the version indicates the service level to
which the product has been updated. Prior to applying any service the version is
7.0.0.0. As service is applied the last two digits will be updated, for example to
7.0.0.1 or 7.0.2.1. To view the version, do one of the following:
v Use the dspmqver command. At a command prompt, enter the following

command: dspmqver. The resulting messages include the WebSphere MQ version
number, which shows the service level.

v Locate the file README.TXT in the appropriate language subfolder of the
WebSphere MQ program files folder (default C:\Program Files\IBM\WebSphere
MQ\), then open it using a suitable text editor. The file contains the service level
and details of the maintenance applied.

Applying the maintenance information

You can install the updates from the WebSphere MQ Web site (see “Installing
updates from the WebSphere MQ Web site” on page 92). Windows Vista and
Windows Server 2008 users with UAC enabled must apply maintenance packages
to WebSphere MQ with Administrator authority.
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Installing updates from the WebSphere MQ Web site
About this task

To install maintenance packages from the WebSphere MQ Web site:
1. Select a destination folder for the supplied executable file.
2. When the file has been downloaded, change to the destination folder and either

run the executable file or see “Silently installing maintenance updates” for
information on silently installing a maintenance pack. Windows Vista and
Windows Server 2008 users with UAC enabled must install the update with
Administrator authority: Right-click on the executable file and select Run as
administrator.

3. Running this file presents you with a dialog screen on which you can choose to
temporarily unpack or save the executable file. Select the appropriate option
(and if saving select the default folder, or change it if required) and click Install

4. Click Finish when the file has been unpacked into the temporary folder to end
the dialog.

Results

The installation program amqicsdn.exe file now runs and presents you with a
dialog screen on which you can choose a folder in which to back up any files that
are to be changed by the maintenance process.

Note: Use the default folder for the backup operation.

Silently installing maintenance updates
About this task

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

To apply maintenance updates to WebSphere MQ:
1. Stop all existing WebSphere MQ processes.

a. Stop execution of all WebSphere MQ applications on the local machine, and
on any connected remote machines.

b. Stop execution of all queue managers by issuing the following command for
each queue manager:
endmqm -i QMgrName

where QMgrName is the name of an active queue manager.
c. Stop execution of all channels
d. Stop execution of all listeners
e. Right click WebSphere MQ on the system tray and select Stop WebSphere

MQ. Wait for all services to stop.
f. Right click WebSphere MQ on the system tray and select Exit.

2. Change to the directory into which you downloaded the refresh pack or fix
pack file.
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3. In Windows Explorer, right-click the fix pack file and select Open.
Alternatively, enter the following command at a command prompt:
MaintenanceLauncher [-s] -a install_arguments

where:

MaintenanceLauncher
is the full path to the fix pack or refresh pack executable file, for example:
WebSphereMQMDV7.0.1.0EnUs.exe.

-s is optional and means that the maintenance launcher extracts silently. If
you omit this, a progress of extraction panel is displayed.

-a means ’read in the following install arguments’

install_arguments
are the arguments that determine how the installer runs. These are
specified in PROPERTY=value pairs. Table 15 shows the properties that can
be used as install_arguments.

Table 15. Properties used to install a maintenance update

Property Values Description

MQPLOG path\file_name Pass a valid path to specify the log to be used
during install/uninstall, for example
MQPLOG="C:\TEMP\UPDATEINSTALL.LOG"

MQPBACKUPPATH path Specifies the directory to backup into during
install, for example MQPBACKUPPATH="C:\BACKUP"

MQPREBOOT 0|1 Specifies what to do when a reboot is required, for
example MQPREBOOT=1.

If no value is supplied, you will be prompted
for what to do.

If MQPREBOOT is set to 0, a reboot will be
supressed

If MQPREBOOT is set to 1, the reboots will go
ahead without prompting.

MQPSILENT 0|1 Specifies whether to do a silent install or not, for
example MQPSILENT=1.

If no value is supplied, or if MQPSILENT is set
to 0, the install is interactive.

If MQPSILENT is set to 1, the install is silent.

MQPINUSEOK 0|1 Specifies whether to continue even if a file is
found to be currently locked by another
application. If you choose to continue even if a file
is currently locked by another application, then
you will need to reboot to complete fixpack
installation.

If no value is supplied, or if MQPINUSEOK is
set to 0, the installation will fail if files are
found to be in use by other applications.

If MQPINUSEOK is set to 1, the installation
will be deferred until you reboot.

MQPUNINST 0|1 Specifies the removal of the last fixpack.

If no value is supplied, or if MQPUNINST is
set to 0, the fixpack will be installed.

If MQPUNINST is set to 1, the latest fixpack
will be uninstalled.
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An example of a command to install a maintenance update silently is:
WebSphereMQMDV7.0.1.0EnUs.exe -s -a MQPLOG="C:\TEMP\UPDATEINSTALL.LOG"
MQPBACKUPPATH="C:\BACKUP" MQPSILENT=1

Results

After successful extraction the installer runs automatically according to the chosen
arguments. If the install completes successfully, you will see the message
Installation operation completed successfully in the log file you specified in
your command. You can also use the Windows Task Manager to see when the
process has completed.

What to do next

When you have completed the installation, review the memo supplied in the
readme directory, and complete any manual post-installation tasks required.

Restoring the previous backup version
About this task

If you need to restore WebSphere MQ to a previous level of maintenance:
1. Ensure that you are logged on as an Administrator.
2. Ensure that all queue managers are stopped.
3. Ensure that all channel listeners are stopped.
4. Ensure that the IBM WebSphere MQ Service has stopped.
5. Click either
v Start → Programs → IBM WebSphere MQ → Remove Refresh Pack

v Start → Programs → IBM WebSphere MQ → Remove Fix Pack

6. Click Remove to start the process. This returns the installation to the state it
was in before the maintenance package was applied.

Silently restoring the previous backup version
About this task

If you need to silently restore WebSphere MQ to a previous level of maintenance:

If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent installation
from an elevated command prompt. Elevate a command prompt by using a
right-click to start the command prompt and choose Run as administrator. If you
try to silently install from a non-elevated command prompt, the install fails with
an error of AMQ4353 in the install log.

To apply maintenance updates to WebSphere MQ:
1. Ensure that all WebSphere MQ function is stopped. You must:

a. Stop execution of all queue managers
b. Stop execution of all channels
c. Stop execution of all listeners
d. Ensure the WebSphere MQ service has stopped

2. Exit all Windows programs before uninstalling maintenance to WebSphere MQ.
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3. Change to the directory into which you downloaded the refresh pack or fix
pack file.

4. Enter the following command at a command prompt: MaintenanceLauncher
[-s] -a uninstall_arguments

where:

MaintenanceLauncher
is the full path to the fix pack or refresh pack executable file, for example:
WebSphereMQMDV7.0.1.0EnUs.exe.

-s is optional and means that the maintenance launcher extracts silently. If
you omit this, a progress of extraction panel is displayed.

-a means ’read in the following arguments’

uninstall_arguments
are the arguments that determine how the installer runs. These are
specified in PROPERTY=value pairs. Table 16 shows the properties that can
be used as uninstall_arguments.

Table 16. Properties used to uninstall a maintenance update

Property Values Description

MQPLOG path\file_name Pass a valid path to specify the log to be used
during install/uninstall, for example
MQPLOG="C:\TEMP\UPDATEINSTALL.LOG"

MQPREBOOT 0|1 Specifies what to do when a reboot is required, for
example MQPREBOOT=1.

If no value is supplied, you will be prompted
for what to do.

If MQPREBOOT is set to 0, a reboot will be
supressed

If MQPREBOOT is set to 1, the reboots will go
ahead without prompting.

MQPSILENT 0|1 Specifies whether to do a silent install or not, for
example MQPSILENT=1.

If no value is supplied, or if MQPSILENT is set
to 0, the install is interactive.

If MQPSILENT is set to 1, the install is silent.

MQPINUSEOK 0|1 Specifies whether to continue even if a file is
found to be currently locked by another
application. If you choose to continue even if a file
is currently locked by another application, then
you will need to reboot to complete fixpack
uninstallation.

If no value is supplied, or if MQPINUSEOK is
set to 0, the uninstallation will fail if files are
found to be in use by other applications.

If MQPINUSEOK is set to 1, the uninstallation
will be deferred until you reboot.

MQPUNINST 0|1 Specifies the removal of the last fixpack.

If no value is supplied, or if MQPUNINST is
set to 0, the fixpack will be installed.

If MQPUNINST is set to 1, the latest fixpack
will be uninstalled.

An example of a command to uninstall a maintenance update silently is:
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WebSphereMQMDV7.0.1.0EnUs.exe -s -a MQPLOG="C:\TEMP\UPDATEINSTALL.LOG"
MQPSILENT=1 MQPUNINST=1

Results

The uninstaller runs automatically according to the chosen arguments. If the
uninstall completes successfully, you will see the message Installation operation
completed successfully in the log file you specified in your command. The
WebSphere MQ installation returns to the state is was in before the maintenance
package was applied. You can also use the Windows Task Manager to see when
the process has completed.

What to do next

When you have completed the uninstallation, review the memo supplied in the
readme directory, and complete any manual post-uninstallation tasks required.
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Chapter 8. Uninstalling WebSphere MQ

This topic describes how to uninstall WebSphere MQ if you installed it by using
the WebSphere MQ Server CD.

If you installed the WebSphere MQ client using the WebSphere MQ Client CD, use
one of the methods described in the WebSphere MQ Clients book.

You can uninstall (remove) WebSphere MQ in attended mode or unattended
(silent) mode.

If you are uninstalling the WebSphere MQ server, see “Uninstalling WebSphere
MQ Server” on page 98.

If you are uninstalling the WebSphere MQ client, see “Uninstalling WebSphere MQ
Client” on page 102.

Note: If you are uninstalling WebSphere MQ Version 7.0 in order to reinstall
WebSphere MQ Version 6.0, and your installation included the WebSphere MQ
Explorer, you must also uninstall the WebSphere Eclipse Platform, Version 3.3,
because the Version 6.0 WebSphere MQ Explorer does not run with the WebSphere
Eclipse Platform, Version 3.3. For instructions on uninstalling WebSphere Eclipse
Platform, see “Installing and uninstalling IBM WebSphere Eclipse Platform” on
page 15.

Uninstalling WebSphere MQ Explorer
If you uninstall the WebSphere MQ Explorer, you must first remove some
configuration files.

About this task

For each of the users whom have logged into WebSphere MQ Explorer:
1. Optional: Save a copy of any WebSphere MQ Explorer settings you want to

keep (such as column schemes, remote queue manager definitions, and user
preferences). To do this:
a. Right-click IBM WebSphere MQ in the WebSphere MQ Explorer navigator

pane.
b. Select Export MQ Explorer settings.
c. Select the types of settings you want to export from the list.
d. Select a file to save your exported settings in.
e. Click OK.
f. Close the WebSphere MQ Explorer.

2. Optional: Save a copy of any data that user-defined plug-ins are saving in
C:\Documents and Settings\username\Application Data\IBM\MQ
Explorer\.metadata\.plugins\com.ibm.mq.explorer.ui, where username is your
user name.

3. Delete the following directory:
C:\Documents and Settings\username\Application Data\IBM\MQ Explorer\.metadata
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where username is your user name.
4. Delete the following directory:

C:\Documents and Settings\username\.eclipse

where username is your user name.
5. In the following directory, delete any subdirectories. Do not delete the file

config.ini:
path\eclipse\configuration

where path is the full path to the directory where you installed WebSphere
Eclipse Platform. By default this is C:\Program Files\IBM\Websphere
MQ\eclipseSDK33.

6. Repeat steps 1 on page 97 to 4 for each of the users whom have logged into
WebSphere MQ Explorer.

Uninstalling WebSphere MQ Server
About this task

If you are going to uninstall the WebSphere MQ Explorer, see “Uninstalling
WebSphere MQ Explorer” on page 97 before uninstalling WebSphere MQ.

Before you uninstall WebSphere MQ, ensure that there are no WebSphere MQ
programs or processes running. To do this:
1. Ensure that all WebSphere MQ function is stopped. You must:

a. Stop execution of all WebSphere MQ applications on the local machine, and
on any connected remote machines.

b. Stop execution of all queue managers
c. Stop execution of all channels
d. Stop execution of all listeners

2. Stop WebSphere MQ. To do this right click the WebSphere MQ icon in the
system tray, then select Stop WebSphere MQ.

3. Exit WebSphere MQ. To do this right click the WebSphere MQ icon in the
system tray, then select Exit.

4. Close all WebSphere MQ windows.
5. Stop any monitoring service.

What to do next

If you are running WebSphere MQ with the Microsoft Cluster Service (MSCS),
remove the queue managers from MSCS control before uninstalling WebSphere
MQ. Perform the following steps for each queue manager currently under MSCS
control :
1. Take the queue manager resource offline.
2. Destroy the resource instance.
3. Migrate the queue manager files back from shared drives. (This step is shown

as optional in the WebSphere MQ System Administration Guide. However, it is
mandatory in this case.)
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For instructions on removing a queue manager from MSCS control, see the
WebSphere MQ System Administration Guide. When you have done this for all
queue managers in the cluster, uninstall WebSphere MQ as described in this
section.

There are three ways to uninstall WebSphere MQ from your machine:
v Start the installation process, then select the appropriate option as described in:

“Uninstalling WebSphere MQ using the installation process”
v On Windows 2003 and Windows XP, use the Add/Remove Programs facility in

the Windows Control Panel. On Windows Vista and Windows Server 2008, use
the Uninstall button in the Programs and Features facility in the Windows
Control Panel. This process is described in: “Uninstalling WebSphere MQ using
Add/Remove Programs or Programs and Features” on page 100

v Perform a removal from the command line as described in: “Uninstalling
WebSphere MQ using msiexec” on page 101

You can use these methods to uninstall the WebSphere MQ server or the
WebSphere MQ client, provided that the original installation used the WebSphere
MQ Server CD (that is, not the WebSphere MQ Client CD).

You can also uninstall WebSphere MQ by using the appropriate parameters with
msiexec or MQParms, or by using Microsoft System Management Server (SMS).
See “Uninstalling WebSphere MQ using msiexec” on page 101 for more
information about msiexec.

Uninstalling WebSphere MQ using the installation process
About this task

This procedure uninstalls WebSphere MQ from your machine in attended mode. It
removes all the currently installed features, although you have the option to keep
existing queue managers and their objects.
1. Insert the WebSphere MQ for Windows Server CD into the CD-ROM drive.
2. If autorun is enabled, the installation process starts.

Otherwise, double-click the Setup icon in the root folder of the CD to start the
installation process.
The WebSphere MQ Installation Launchpad window is displayed.

3. Click the WebSphere MQ Installation.
4. Click Launch IBM WebSphere MQ Installer. Wait until the WebSphere MQ

Program Maintenance panel is displayed with a welcome message.
If this panel is not displayed, WebSphere MQ for Windows, Version 7.0 is not
installed on this machine.

5. Select Remove, then click Next.
6. If there are any existing queue managers, the Removing Server feature panel is

displayed.
Click one of the following options, then click Next:
v Keep – keep existing queue managers and their objects.
v Remove – remove existing queue managers and their objects.

7. The Remove WebSphere MQ panel is displayed, with a summary of the
installation to be removed.
Click Remove to continue.

8. The Removing WebSphere MQ panel is displayed.
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Wait for the progress bar to complete.
If there are any messages that state that locked files are found, ensure that there
are no WebSphere MQ programs running, as described at the start of this topic.
Uninstallation should then continue.

9. The WebSphere MQ Setup window displays the following message:
Uninstallation Completed Successfully
Click Finish.

Uninstalling WebSphere MQ using Add/Remove Programs or
Programs and Features

1. For Windows XP and Windows 2003, use the following procedure:
a. From the Windows taskbar, click Start → Settings → Control Panel

b. Click Add/Remove Programs. The Add/Remove Programs window opens.
c. Click IBM WebSphere MQ.
d. Do one of the following:
v Click Remove. When a confirmation prompt is displayed, click Yes. The

uninstall program begins. All the WebSphere MQ files are removed, but
not your queue managers.
You have uninstalled WebSphere MQ - proceed to Step 3.

v Click Change. The WebSphere MQ Setup window with the Program
Maintenance panel is displayed.
Follow the procedure from the next step:

e. Select Remove, then click Next.
f. If there are any existing queue managers, the Removing Server feature panel

is displayed.
Click one of the following options, then click Next:
v Keep – keep existing queue managers and their objects.
v Remove – remove existing queue managers and their objects.

g. The Remove WebSphere MQ panel is displayed, with a summary of the
installation to be removed.
Click Remove to continue.

h. The Removing WebSphere MQ panel is displayed.
Wait for the progress bar to complete.
If there are any messages that state that locked files are found, ensure that
there are no WebSphere MQ programs running, as described at the start of
this topic.
Uninstallation should then continue.

i. The WebSphere MQ Setup window displays the following message:
Uninstallation Completed Successfully
Click Finish.

2. For Windows Vista and Windows Server 2008, use the following procedure:
a. From the Windows taskbar, click Start → Control Panel. The Programs

window opens.
b. Double-click Programs and Features. The Programs and Features window

opens.
c. Click IBM WebSphere MQ.
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d. Click the Uninstall button. A window containing a confirmation prompt
opens. Click Yes. If UAC is enabled, accept the Windows prompt to allow
the uninstall to run as elevated. The uninstall program then begins and runs
to completion.

3. To uninstall the WebSphere Eclipse Platform see “Installing and uninstalling
IBM WebSphere Eclipse Platform” on page 15.

Uninstalling WebSphere MQ using msiexec
About this task

To invoke an uninstallation, you use the msiexec command. The file used for both
installation and uninstallation, IBM WebSphere MQ.msi, is available on the Server CD
that was used to install WebSphere MQ.

To uninstall all WebSphere MQ features, enter one of the following commands:
v msiexec /i "path\MSI\IBM WebSphere MQ.msi" REMOVE="All"

This command invokes an interactive installation giving you the option to
remove queue manager data.
If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you might see Open File - Security
Warning dialog boxes that list International Business Machines Limited as the
publisher during uninstallation. Click Run to allow the uninstallation to
continue.

v msiexec /i "path\MSI\IBM WebSphere MQ.msi" /q REMOVE="All"

This command invokes a silent uninstall and does not remove any queue
manager data. If you are running WebSphere MQ on Windows Vista or
Windows Server 2008 with User Account Control (UAC) enabled, you must
invoke the silent uninstallation from an elevated command prompt. Elevate a
command prompt by using a right-click to start the command prompt and
choose Run as administrator.

v msiexec /i "path\MSI\IBM WebSphere MQ.msi" /q REMOVE="All"
KEEPQMDATA="delete"

This command invokes a silent uninstall and removes any queue manager data.
If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you must invoke the silent
uninstallation from an elevated command prompt. Elevate a command prompt
by using a right-click to start the command prompt and choose Run as
administrator.

v msiexec /x "path\MSI\IBM WebSphere MQ.msi"

This command displays only a progress dialog while uninstalling and does not
remove any queue manager data.
If you are running WebSphere MQ on Windows Vista or Windows Server 2008
with User Account Control (UAC) enabled, you might see Open File - Security
Warning dialog boxes that list International Business Machines Limited as the
publisher during uninstallation. Click Run to allow the uninstallation to
continue.

v msiexec /x "path\MSI\IBM WebSphere MQ.msi" /q

This command invokes a silent uninstall and does not remove any queue
manager data. If you are running WebSphere MQ on Windows Vista or
Windows Server 2008 with User Account Control (UAC) enabled, you must
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invoke the silent uninstallation from an elevated command prompt. Elevate a
command prompt by using a right-click to start the command prompt and
choose Run as administrator.

Note: path refers to the path to the file IBM WebSphere MQ.msi. This file can be
found on the Server CD.

Results

Alternatively, you can use the msiexec command with a parameter that calls a
response file. A response file is an ASCII text file that contains the parameter
values that you want to set for the uninstallation. The response file has a format
similar to a Windows .ini file, and contains the stanza [Response]. This stanza
contains parameters that the msiexec command can use, in the form of
property=value pairs. The msiexec command ignores any other stanzas in the file.

You can set which features to uninstall, and set whether to keep existing queue
managers.

Note: The response file you use to uninstall WebSphere MQ for Windows, Version
7.0 when it was installed using the WebSphere MQ Server CD is not the same as
the one used with earlier non-MSI versions of MQSeries such as versions earlier
then 5.3. For details about the response file you use with the WebSphere MQ Client
CD, see the WebSphere MQ Clients book.

To silently uninstall WebSphere MQ using a response file, enter the following
command:
msiexec /i "path\MSI\IBM WebSphere MQ.msi" /q USEINI="response_file"

where response_file is the file that contains the [Response] stanza and the required
property=value pairs. For details about how to create a response file, see
“Unattended (silent) installation” on page 28. For details of the parameters you can
specify in a response file, see Table 6 on page 34.

An example of a typical uninstallation response file is:
[Response]
KEEPQMDATA="delete"
REMOVE="Server,Client"

Uninstalling WebSphere MQ server using MQParms

To silently uninstall using MQParms, follow the instructions on the installation
pages, but set the ADDLOCAL parameter to empty, and set the REMOVE
parameter to ″ALL″.

For example ADDLOCAL=″″ and REMOVE=″ALL″.

The instructions for MQParms begin here: “Using the MQParms command” on
page 41

Uninstalling WebSphere MQ Client
This section describes how to uninstall WebSphere MQ client. There are two cases
for this:
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v If you installed the WebSphere MQ client using the WebSphere MQ Client CD,
use one of the methods described in the WebSphere MQ Clients book.

v If you installed the WebSphere MQ client using the WebSphere MQ Server CD,
use one of the methods described in “Uninstalling WebSphere MQ Server” on
page 98.
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Chapter 9. WebSphere MQ documentation

This topic describes the documentation for WebSphere MQ for Windows. It starts
with a list of the publications, including their PDF filenames, and then discusses:
v “WebSphere MQ Information Center” on page 106
v “Hardcopy books” on page 113
v “Online information” on page 113

If there is similar information in this book and any of the books in the following
list, the information in this book should take precedence.

WebSphere MQ is described in the following books:

Table 17. WebSphere MQ Quick Beginnings books

PDF file name Order Number Title

AMQAAC10 GC34-6922 WebSphere MQ for AIX® Quick Beginnings

AMQCAC09 GC34-6923 WebSphere MQ for HP-UX Quick Beginnings

AMQWAC04 GC34-6925 WebSphere MQ for i5/OS® Quick Beginnings

AMQ1AC07 GC34-6924 WebSphere MQ for Linux Quick Beginnings

AMQTAC07 GC34-6920 WebSphere MQ for Windows Quick Beginnings

AMQDAC10 GC34-6921 WebSphere MQ for Solaris Quick Beginnings

Table 18. WebSphere MQ family books

PDF file name Order Number Title

CSQZAL12 SC34-6939 WebSphere MQ Application Programming Guide

CSQZAK11 SC34-6940 WebSphere MQ Application Programming Reference

CSQZAY04 SC34-6947 WebSphere MQ Bibliography and Glossary

CSQZAF10 GC34-6934 WebSphere MQ Clients

CSQZAQ01 SC34-6951 WebSphere MQ Constants

CSQZAE10 SC34-6931 WebSphere MQ Intercommunications

AMQZAO06 GC34-6945 WebSphere MQ Messages

CSQZAO01 GC34-6948 WebSphere MQ Migration Information

CSQZAX06 SC34-6937 WebSphere MQ Monitoring

CSQZAC06 SC34-6942 WebSphere MQ Programmable Command Formats and Administration
Interface

AMQNAR11 SC34-6950 WebSphere MQ Publish/Subscribe User’s Guide

CSQZAH08 SC34-6933 WebSphere MQ Queue Manager Clusters

CSQZAS04 SC34-6932 WebSphere MQ Security

CSQZAJ11 SC34-6941 WebSphere MQ Script (MQSC) Command Reference

AMQZAG10 SC34-6928 WebSphere MQ System Administration Guide

AMQZAN10 SC34-6936 WebSphere MQ Using C++

CSQZAW16 SC34-6935 WebSphere MQ Using Java

CSQZAV06 GC34-6949 WebSphere MQ Using .NET
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Table 18. WebSphere MQ family books (continued)

PDF file name Order Number Title

CSQSAT04 GC34-6926 WebSphere MQ for z/OS® Concepts and Planning Guide

CSQSAV05 SC34-6927 WebSphere MQ for z/OS System Setup Guide

CSQSAW04 SC34-6929 WebSphere MQ for z/OS System Administration Guide

CSQSAQ04 GC34-6944 WebSphere MQ for z/OS Problem Determination Guide

CSQSAO06 GC34-6946 WebSphere MQ for z/OS Messages and Codes

CSQSAD05 GI10-2584 Program Directory for WebSphere MQ for z/OS

Table 19. WebSphere MQ for Windows books

PDF file name Order Number Title

AMQTAN04 SC34-6938 WebSphere MQ Using the Component Object Model Interface

AMQZAV06 SC34-6949 WebSphere MQ Using .NET

Table 20. Additional WebSphere MQ books for i5/OS

PDF file name Order Number Title

AMQWAK02 SC34-6943 WebSphere MQ for i5/OS Application Programming Reference

AMQWAG04 SC34-6930 WebSphere MQ for i5/OS System Administration Guide

WebSphere MQ Information Center
The WebSphere MQ Information Center is supplied separately on a CD alongside
the product. You can either view the Information Center directly from CD, or you
can install it on your computer (either before or after installing the WebSphere MQ
product).

Viewing the Information Center

You can view the Information Center on any Windows system supported by the
WebSphere MQ product.

When you insert the Documentation CD, the welcome panel opens. If it does not
appear when you insert the Documentation CD, you can run the CD from
Windows Explorer.

To open and view the Information Center without installing it, click the View
Information Center icon:

The Information Center launches in a browser window.

To close the Information Center, click the Close Information Center icon:
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Installing the WebSphere MQ Information Center

You can install the Information Center on any Windows operating system
supported by the WebSphere MQ product.

To install the Information Center:
1. Insert the Documentation CD. The welcome panel opens. If it does not appear

when you insert the Documentation CD, you can run the CD from Windows
Explorer.

2. Click the Install icon to install the Information Center:

3. Click Next to start the InstallShield Wizard for the WebSphere MQ Version 7
Information Center.

4. Accept the license agreement terms and work through the panels in the
InstallShield Wizard for the WebSphere MQ Version 7 Information Center
wizard.

5. Choose a directory to install the Information Center to.
6. Select which languages to install. English is always installed.

The Information Center is installed as an Eclipse plugin to the directory you
specified in the Wizard. The default installation location for the English language
version is:

C:\Program Files\IBM\Websphere MQ\eclipse\plugins\
com.ibm.mq.explorer.doc_7.0.0.0

Different languages are installed to different default locations, for example:

C:\Program Files\IBM\Websphere MQ\eclipse\plugins\
com.ibm.mq.explorer.doc.nl1.**_7.0.0.0

where ** is the relevant language code.

When the installation is complete you can choose any or all of the following
options:
v View the readme file
v See how to request updated documents
v Start the Information Center

Alternatively, click Close to close the Wizard.
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Running the WebSphere MQ Information Center

When you have installed the Information Center you can run it from Windows
Explorer:
1. Open Windows Explorer
2. Navigate to the directory you installed the Information Center in.
3. You can run the Information Center in two modes:

Standalone mode
In standalone mode, the Information Center is available only to the
user who is logged in to the machine that is running the Information
Center.

To run the Information Center in standalone mode, double-click
start.exe

Alternatively, you can select Start -> All Programs -> WebSphere MQ
7 Information Center -> Start Help

Information Center mode
In Information Center mode, the Information Center is available to
users on other machines in the same network as the machine that is
running the Information Center. Using this mode, you can have an
Information Center that is installed on one machine, and make it
available to many users.

To run the Information Center in Information Center mode,
double-click IC_start.bat

Alternatively, you can select Start -> All Programs -> WebSphere MQ
7 Information Center -> Start Information Center

The Information Center uses a web server that is included with the
system. The web server uses a random port to avoid port conflicts
among applications, and by default the listener is disabled. The default
port used is 8888.

Stopping the Information Center

To stop the Information Center when it is running in standalone mode,
double-click <Information_Center_Install_Dir>/stop.exe, or select Start -> All
Programs -> WebSphere MQ 7 Information Center -> Stop Help.

To stop the Information Center when it is running in Information Center mode,
double-click <Information_Center_Install_Dir>/IC_end.bat, or select Start -> All
Programs -> WebSphere MQ 7 Information Center -> Stop Information Center.

Updating the Information Center

When newer versions of the documentation in the Information Center are
available, you can download the updated content from within the help system.

To check whether there are any updates available and download them to your
local system:
v Click Update

on the tool bar. A list of installed document sets is displayed.
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v Click Find Updates on the bottom of the list to start finding available updates.
The help system searches for updates at a server location. A progress bar is
displayed while updates are being located.

v When updates have been located, in the search results for the latest updates, two
lists are displayed:
– Updates for existing documentation
– New documentation

Select the check boxes corresponding to the documentation sets you want to
install.

v Click Install Updates to install the documentation sets you have selected.
v Click Finish when the installation is done.

You do not need to restart the help system. It will refresh automatically to show
the updated content.

Using the WebSphere MQ information center
The WebSphere MQ information center is built on the IBM Eclipse Help System.
The WebSphere MQ information center can be launched in two modes: Standalone
mode and Information Center mode. During the information center installation,
chose whether the information center will run in either one, or both of these
modes.

Viewing the information center in Standalone mode
In Standalone mode, only the user that launched the help system can view the
help.

About this task

When the IBM Eclipse Help System is launched in Standalone mode, the help
system’s embedded web application server uses a random port to avoid port
conflicts between applications, and a new browser window or tab is automatically
opened, with the information center home page displayed. There might be a slight
delay before the browser window or tab opens, while the application server
initializes.

Launching the information center in Standalone mode
About this task

To launch the Help System in Standalone mode from the Start Menu select Start →
All Programs → IBM WebSphere 7.0.0 Information Center → Start Help.

Stopping the information center in Standalone mode

To stop the information center when it is running in Standalone mode, from the
Start Menu select Start → All Programs → IBM WebSphere 7.0.0 Information
Center → Stop Help.

Displaying the documentation in different languages

To view the information center in another language in Standalone mode, change
the regional settings of your operating system to the locale and language of your
choice. When you are viewing documentation in your chosen language, topics that
have not been translated into your chosen language are displayed in English.
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Viewing the information center in Information Center mode
In Information Center mode, the information center is available from other
machines on the same network as the machine on which the help system is
running.

About this task

When the information center is launched in Information Center mode, the IBM
Eclipse Help System’s embedded web application server uses port 8888, unless the
installation wizard detected that port was already in use by another application, in
which case it uses the port that was specified when the help system was installed.
A new browser tab or window is not automatically opened.

When you launch the information center in Information Center mode from the
Start Menu, a Windows service is started. You can use this service to make the
information center available across a network: when the service is started, you do
not need to be logged into the machine that is running the help system.

Launching the information center in Information Center mode
About this task

To launch the information center in Information Center mode from the Start Menu
select Start → All Programs → IBM WebSphere 7.0.0 Information Center → Start
Information Center.

Results

In Information Center mode, the information center is available from the local
machine at the following URL:

http://127.0.0.1:<port>/help/index.jsp

For example, if the default port is used, the URL is http://127.0.0.1:8888/help/
index.jsp.

In Information Center mode, the information center is available from other
machines on the same network as the machine on which the information center is
running, at the following URL:

http://<ip address>:<port>/help/index.jsp

Where <ip address> is the IP address of the machine on which the information
center is running.

Stopping the information center in Information Center mode

To stop the information center when it is running in Information Center mode,
from the Start Menu select Start → All Programs → IBM WebSphere 7.0.0
Information Center → Stop Information Center.

Displaying the documentation in different languages

To view the information center in another language in Information Center mode,
set the language option in your browser so that your desired language is the first
one that is specified, clear the browser cache, and refresh your browser view.
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When you are viewing documentation in your chosen language, topics that have
not been translated into your chosen language are displayed in English.

Configuring to allow all users to launch the information center
When an administrator installs the IBM WebSphere MQ Version 7.0.0 Information
Center from the WebSphere MQ 7 Information Center CD on Windows or Linux,
only users with administrator privileges on Windows and the root user on Linux
are initially able to launch the information center.

About this task

When the information center is launched, it attempts to create or update the
following folders, or files and subfolders of these folders:
v <install directory>/eclipse/configuration
v <install directory>/eclipse/workspace

These folders contain information specific to the installed instance of the
information center, such as search indexes, and information that the IBM Eclipse
Help System uses to identify the help plug-ins that are installed. To allow users
who do not have administrator authority on Windows, or root access on Linux, to
launch the information center, allow write access to these folders (on Windows), or
change the location of these folders (on Linux).

Use the following instructions to configure the information center for use by all
users on both Windows and Linux.

Configuring to allow all users to launch the information center
on Windows

About this task

To allow all users to launch the information center on Windows systems, you need
to allow users write access to the <install directory>/eclipse directory. To do this:
1. Log in as a member of the administrators group.
2. In Windows Explorer, navigate to <install directory>.
3. Right-click the ’eclipse’ directory, and select ’Properties’.
4. Select the Security tab.
5. In the Group or User Names panel, Select the ’Users’ group.
6. In the Permissions for Users panel, make sure the checkbox in the ’Allow’

column and the ’Write’ row is selected.
7. Click OK.

Results

The information center is now set up so that all users can run the information
center in Standalone mode.

Only a member of the administrators group can launch the information center in
Information Center mode from the Start Menu, because launching the information
center in this way starts a Windows service, which a user who is not a member of
the administrators group does not have sufficient authority to do.
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Configuring to allow all users to launch the information center
on Linux

About this task

On Linux systems you can allow all users to launch the information center in both
modes by carrying out the following steps:
1. Install the IBM WebSphere MQ Version 7.0.0 Information Center from the

WebSphere MQ 7 Documentation CD to the default installation path.
2. Modify the scripts used to start and stop the information center.
v <install directory>/Help_start.sh
v <install directory>Help_end.sh
v <install directory>IC_start.sh
v <install directory>IC_end.sh

Add the following text to each file before ’-command...’:
-data $HOME/.mqdata/MQ70Info/workspace
-configuration $HOME/.mqdata/MQ70Info/configuration

These parameters instruct the information center to use configuration and
workspace folders in the user’s home directory. Each user will have a separate
configuration and workspace folder.

PDF
A PDF (Portable Document Format), corresponding to each book, is available on
the documentation CD. You can read PDFs using Adobe® Acrobat Reader. You can
download them to your own file system, or you can print them on a PostScript
printer.

The PDFs are available in U.S. English in the \docs\pdf\en_US directory on the
Documentation CD, and also in some or all of the following national languages.
After you have installed the PDFs, you can find the files in the directory in which
you installed the Information Center. To find out which ones are available in your
language, look for the appropriate directory on the CD in the form
\docs\pdf\ll_LL, where ll_LL is one of the following:
v cs_CZ (Czech)
v de_DE (German)
v es_ES (Spanish)
v fr_FR (French)
v hu_HU (Hungarian)
v it_IT (Italian)
v ja_JP (Japanese)
v ko_KR (Korean)
v pl_PL (Polish)
v pt_BR (Brazilian Portuguese)
v ru_RU (Russian)
v zh_CN (Simplified Chinese)
v zh_TW (Traditional Chinese)

Within these directories, you can find the complete set of PDFs that are available.
Table 17 on page 105 shows the file names used for the PDF files.
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Infopops in the WebSphere MQ Explorer
Infopops are provided in the WebSphere MQ Explorer for Windows and Linux.
They provide context-sensitive help from any part of the GUI.

You can:
v Click a folder
v Click a properties page
v Click a view
v Click a dialog

then press F1 on Windows installations or Ctrl+F1 on Linux installations. By
default, help information that typically contains one or more links to more detailed
information, is displayed in a new panel in WebSphere MQ Explorer. Alternatively,
the infopops can be set to display as a small yellow box that hovers over the
cursor.

Hardcopy books

This book, and all the books listed in Table 17 on page 105 and Table 18 on page
105, are available for you to order or print.

You can order publications from the IBMLink™ Web site at:

https://www.ibm.com/ibmlink/link2/logon/logonPage.jsp

In the United States, you can also order publications by dialing 1-800-879-2755.

In Canada, you can order publications by dialing 1-800-IBM-4YOU
(1-800-426-4968).

For further information about ordering publications, contact your IBM authorized
dealer or marketing representative.

For information about printing books, see “WebSphere MQ Information Center” on
page 106.

Online information
This section describes the sources of information available online about WebSphere
MQ Version 7.0:

PDF books on the World Wide Web

The WebSphere MQ books are available on the World Wide Web as well as on the
product CD. They are available in PDF format. The WebSphere MQ product family
Web site is at:

http://www.ibm.com/software/integration/wmqfamily

By following links from this Web site you can:
v Obtain latest information about the WebSphere MQ product family.
v Access the WebSphere MQ books in PDF format.
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Online help

WebSphere MQ Support

Information about the support available for WebSphere MQ can be found from the
following Web site:

http://www.ibm.com/software/integration/wmq/support/

SupportPacs

SupportPacs contain material that complements the WebSphere MQ family
products, for example, there are a number of SupportPacs to help you with
performance and capacity planning. Many SupportPacs are freely available for
download, others can be purchased as a fee-based service. SupportPacs can be
obtained from the following Web site:

http://www.ibm.com/software/integration/support/supportpacs

WebSphere MQ newsgroups

WebSphere MQ support provides a number of newsgroups where members share
their knowledge and experience with others. A list of the newsgroups can be found
on the following Web page by following the link to discussion groups:

http://www.ibm.com/software/integration/wmq/support/community.html

Whitepapers and migration documents

IBM produces a number whitepapers that contain other useful information about
WebSphere MQ. These can be found at:

http://www.ibm.com/software/integration/websphere/library/whitepapers

Service support summary (Maintenance readmes)

The service support summary gives a summary of the support information and
end of service dates for in-service WebSphere MQ products. This can be found at:

http://www.ibm.com/software/integration/mqfamily/support/summary/
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Notices

This information was developed for products and services offered in the United
States. IBM may not offer the products, services, or features discussed in this
information in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply
that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the user’s responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing,
IBM Corporation,
North Castle Drive,
Armonk, NY 10504-1785,
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation,
Licensing,
2-31 Roppongi 3-chome, Minato-k,u
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the information. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
information at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England
SO21 2JN.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Programming License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

The following are trademarks of International Business Machines Corporation in
the United States, or other countries, or both:

AIX
DB2
i5/OS
IBM
IBMLink
Informix
Supportpac
TXSeries
z/OS
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Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Microsoft, Windows, Windows NT®, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.
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Sending your comments to IBM

If you especially like or dislike anything about this book, please use one of the
methods listed below to send your comments to IBM.

Feel free to comment on what you regard as specific errors or omissions, and on
the accuracy, organization, subject matter, or completeness of this book.

Please limit your comments to the information in this book and the way in which
the information is presented.

To make comments about the functions of IBM products or systems, talk to your
IBM representative or to your IBM authorized remarketer.

When you send comments to IBM , you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate, without incurring
any obligation to you.

You can send your comments to IBM in any of the following ways:
v By mail, to this address:

User Technologies Department (MP095)
IBM United Kingdom Laboratories
Hursley Park
WINCHESTER,
Hampshire
SO21 2JN
United Kingdom

v By fax:
– From outside the U.K., after your international access code use 44-1962-816151
– From within the U.K., use 01962-816151

v Electronically, use the appropriate network ID:
– IBM Mail Exchange: GBIBM2Q9 at IBMMAIL
– IBMLink: HURSLEY(IDRCF)
– Internet: idrcf@hursley.ibm.com

Whichever method you use, ensure that you include:
v The publication title and order number
v The topic to which your comment applies
v Your name and address/telephone number/fax number/network ID.
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